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Presentation

CYPECAD is the software for reinforced concrete and steel buildings which provides the spatial
analysis, structural element design, reinforcement and section edition, and construction drawings of the
structure.

It carries out the analysis of three dimensional structures composed of supports and floor slabs, including
their foundations, and the automatic design of reinforced concrete and steel elements.

With CYPECAD, the engineer holds a precise and efficient tool to resolve all the aspects related
to the analysis of the structure of any type of concrete as well as being adapted to the latest international
Codes.
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1. Program introduction

1.1. General aspects of the working screen

1.1.1. Tabs

The following tabs can be seen at the bottom left hand cor-
ner of the main screen of CYPECAD:

• Column Definition
• Beam Definition
• Results
• Contour Maps
• Deformed shape

Fig. 1.1

By clicking on these tabs, different menus will appear
containing various options for each stage of the building
analysis.

1.1.2. Main menus

The main menus are located at the top of each main win-
dow of CYPECAD. These will allow you to access the va-
rious program options. The menus can also be accessed
via the option bar which can be activated upon clicking the
folder icon at the top right hand corner of the first toolbar.

Fig. 1.2
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1.1.3. First toolbar

The first toolbar has many elements common to all the tabs
and are mainly visualisation and template options.

The Undo and Redo icons within the Column Definition,
Beam Definition and Results tabs, allow to cancel or re-
peat the last modification.

Fig. 1.3

1.1.4. Second toolbar

The program contains a toolbar with shortcuts to the menu
options of the program (within the Column Definition, Be-
am Definition and Results tabs).

These toolbars can be configured by adding or removing
options by clicking on the hand icon (toolbar configuration)
situated on the right of the toolbar.

Fig. 1.4

1.1.5. Background Colours

The choice of background colours of CYPECAD is
limited to three options: white, grey or black. This
way, a greater contrast is created with the colours
of the structural elements and hence an optimum
visualisation is obtained.

The background colour can be selected from the drop
down menu that appears upon clicking on the globe icon
located on the right of the first toolbar.

Fig 1.5
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1.2. On screen help
CYPE programs have on screen help icons to provide the
user with the necessary information on the program me-
nus, dialogue boxes and options.

There are four different ways to access the help options:

1.2.1. Pressing F1

To obtain help on a menu option, press F1. All the icons
with help explanations available will be highlighted in blue.
If you wish to obtain help on an option within a menu, ha-
ving pressed F1, unfold the menu and click on the desired
option.

1.2.2. Question mark icon

A question mark icon can be seen at the top right
hand corner of the title bar. Specific help on a program
option can be obtained the following way: click on the
question mark icon then unfold the menu containing
the option for which the help is sought and click on
the option. A window will appear containing the requi-
red information. This option provides the same infor-
mation as when the F1 key is pressed.

This help can be deactivated in three ways: by clicking
on the right mouse button, by clicking on the question
mark icon or by pressing the Esc key.

You can equally obtain information on the toolbar
icons. Upon selecting the question mark icon , the
icons will be highlighted in blue (as with the F1 op-
tion). By then clicking on the icon, the help information
will be displayed.

Option windows that open within the program also contain
the question mark icon in their title bar. By clicking on it, the
option or icon help can be accessed.

1.2.3. Book icon

Within the title bar of several windows, an open book icon
can be found which upon clicking on it will display ge-

neral information on the contents of the window.

1.2.4. Quick guide

The option information displayed using the F1 key can also
be consulted and printed out by selecting Help > Quick
guide. These explanations are those corresponding to the
options found within the screen tabs.

The explanations in the dialogue boxes are different to
those of the guide.

Fig. 1.6
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1.3. Job introduction
To create a new job, click on File > New. A dialogue box
will appear in which the job location, name and description
of the job are required.

Fig 1.7

Once filled in, click on Accept and a second dialogue box
will appear where the program will prompt the user to
choose between a manual introduction (Empty job), or, if
you possess the corresponding license, an Automatic in-
troduction using a DXF/DWG file or IFC, or if you wish to
view an Automatic introduction example.

Fig. 1.8

Fig. 1.9

1.3.1. Automatic introduction

The job introduction is carried out in various steps with the
help of an assistant which will ask the user to gradually in-
put properties of the job, such as floors, their heights and
respective loads. Depending on which type of automatic in-
troduction is selected, be it using a DXF/DWG template or
an IFC file, the building outline and support elements can
be introduced.

Fig. 1.10
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Fig. 1.11

1.3.1.1. Automatic introduction DXF/DWG

Having defined the building and floor data, the program will
ask for a DXF or DWG file to be uploaded to use as a tem-
plate. One or several files can be uploaded.

Their layer colours can be modified and subsequently the
user will have to choose which layers are to remain visible.
The following window will ask which files are to be applied
to the groups, then which layers are to be used to draw the
element geometries.

Fig. 1.12

Fig. 1.13

Fig. 1.14

Fig. 1.15
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Fig. 1.16

Fig. 1.17

Fig. 1.18

1.3.1.2. Automatic introduction IFC

Upon selecting this option the program will prompt for an
IFC file to be uploaded. Then, in a similar way as with the
other automatic introductions, the building and floor data
will have to be defined. The user will have to select which
materials defined within the imported file are to represent
the various elements of the job and assign properties to
these selections.

Fig. 1.19

Fig. 1.20
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Fig. 1.21

Fig. 1.22

Fig. 1.23

Fig. 1.24
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Fig. 1.25

Fig. 1.26

Fig. 1.27

Once the introduction has concluded, the job will be gene-
rated and the General data window will open to allow for
the design codes and job properties to be selected.

Immediately after, the program will display the Column Defi-
nition window in CYPECAD where all the introduced data
can be modified.

To complete the introduction of the job, the floor slabs, sup-
plementary loads, foundations and any other particular
data must be introduced.
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1.3.2. Manual introduction

If an empty job is chosen, the user must manually intro-
duce all the properties of the job.

In order to simplify the introduction of these properties, it is
important to be methodical. We suggest the following steps
be taken to carry out the project within CYPECAD, or alter-
natively, any other method can be followed as long as the
creation of the information is structured and coherent.

• General data. (Column Definition, Beam Definition
and Results tabs, Job menu). Upon creating a new
job, a name and description must be assigned to it, the
materials to be used and their respective options must
be indicated, as well as the type of control to be under-
taken in its construction.

• Floor definition. (Column Definition tab, Introduc-
tion menu). Description of the levels of the structure,
group organisation, heights between floors and the live
and dead loads they must support.

• Column and shear wall introduction. (Column Defi-
nition tab, Introduction menu). Description of the co-
lumn and shear wall geometry and their respective po-
sitions.

• Wall introduction. (Beam Definition tab,
Beams/Walls menu. Introduction of the walls suppor-
ting the structure.

• Beam introduction. (Beam Definit ion tab,
Beams/Walls menu. Introduction of the beams of the
floor.

• Floor slab introduction. (Beam Definition tab, Panel
menu). Introduction of the floor slabs to be used in the
structure.

• Special load introduction. (Beam Definition tab,
Loads menu). This consists in introducing loads that
have not yet been taken into account, such as those
due to internal partition walls. Please recall that the ge-

neral dead and live loads of the structure have already
been introduced when defining the floors and so need
not be introduced here. The self weight of the suppor-
ting elements (columns, walls, beams and panels) are
generated by the program and so do not have to be in-
troduced.

• Stair introduction. (Beam Definition tab, Job menu).

• Integrated 3D structures introduction. (Beam Defi-
nition tab, Jobmenu). Introduction of the 3D structures
defined in Metal 3D.

• Foundation introduction. (Beam Definition tab,
Foundation menu). Introduction of pad footings, strap
and tie beams. For mat foundations, these must be in-
troduced from the Panels menu at foundation level.

• Analysis of the structure. (Beam Definition tab,
Analyse menu).

• Error identification and correction. (Results tab,
Contour Maps and Deformed Shape). Having analy-
sed the structure, the next step is to check the error
messages related to the structural elements. All those
requiring dimension modifications must be corrected
and then the job must be re-analysed so to verify no er-
rors arise and for the changes in self weight of the
structure to be readjusted. This must be repeated until
those errors implying dimension modifications to be
carried out disappear. If no dimension modifications are
required, the results may be taken as valid.

• Preparation of the results. (Results tab). This is the
previous step to generating the drawings. Here, the
floor slab reinforcement can be edited or made more
uniform, column reinforcement can be modified and co-
lumns may be grouped, if the user wishes to do so. Text
positions can also be corrected here without the need
of having to wait to make the corrections in the dra-
wings.

• Drawings and reports. (File menu, Print option or
Configuration icons at the top right corner of the main
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window). This is the last stage in which the drawings
and/or reports are obtained containing all the desired
information generated by the program based on the in-
troduced, analysed and edited structure.

1.3.3. File management

1.3.3.1. Recent files

A list of the last six jobs that have been opened can be
found by going to File > Recent files. By clicking on
More…, a list of all the jobs opened with that version of the
program will be displayed in chronological order.

1.3.3.2. ASCII file import to generate the foundations

File > Import > Import ASCII file

It is possible to import text files in columns or limited by
commas to generate the foundations based on files expor-
ted from data sheets or other programs.

From the files, the different loadcases are imported, as are
the forces at the column starts for each simple loadcase
and the column base dimensions.

The import process is as follows:

Click on File > Import > Import ASCII file. A window
will emerge asking for the name of the job in which the
foundations are to be created.

Subsequently a new window will open from which the file to
be imported must be selected.

Having concluded the import, the job will have to be analy-
sed.

1.3.3.3. Job examples

The program provides several examples, accessed by
clicking on the Examples icon at the top of the File mana-
ger window.

Fig. 1.28

1.3.3.4. Search

Upon clicking on the Search button, the Search for job
using thesaurus dialogue box appears. This options al-
lows the user to search for jobs in the directory selected in
the previous dialogue box (File manager) which contain the
word indicated by the user in their name or description.

Fig. 1.29
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Fig. 1.30

1.3.3.5. Send, Decompress and Share jobs

These options are found in the File manager window. All
these options deal with compressed jobs i.e. when all the files
of a job are compressed into a single file with .CYP format.

Fig. 1.31

1.3.3.5.1. Send

Using this option, the user can send the job to an email ad-
dress selected from the scroll menu or save the compres-
sed job to a directory of his/her choice (Only compress
job). The user can optionally select whether or not to in-
clude safety copies that may have been created from pre-
vious versions, or to include the associated files (the re-
sults from the last analysis).

Fig. 1.32

1.3.3.5.2. Decompress

This is the opposite to the Send option; it decompresses a
job with .CYP format.

1.3.3.5.3. Share

Using this option, the user can share a job compressed
with .CYP format. The job will be published on a server and
will be accessible to third parties via a private link. There-
fore, only those who know the correct link will have access
to the job.

The user can include a title and a comment on the job to be
shared. Another dialogue box will then appear which indi-
cates the link where the job is located, which may be co-
pied by selecting it using the left mouse button so it may be
provided to the person he/she wishes to see it. This dia-
logue box also opens the website where the job has been
published.

The file links.txt, which is generated in the directory
usr/cype/cypecad contains the links of all the jobs that have
been published.

Any CYPE program screen can be captured to then share
on internet via a private link which the user can then provide
to or publish wherever he/she wishes to. Only those who
know this link will have access to the captured image.

CYPE
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The image capture option is activated by pressing the F12
button of the keyboard whilst the active window on screen
is that of a CYPE program. A dialogue box will then appear
displaying the captured screen image and where the user
can assign it a name and add a comment. Within this dia-
logue box, the user has the option to select only part of the
captured image for it to be published. To do so, select the
area of the image by opening a selection window over the
image using the left mouse button.

Having accepted the dialogue box, the program offers the
user in a different window, two types of URL addresses so
the user may insert the captures in any forum. The selected
address will depend on which forum the URL is to be publi-
shed at. Within the same window, the link which allows ac-
cess to the published screen from any internet connection
is provided.

The file links.txt, which is generated in the directory
usr/cype/cypecad contains the links of all the published
screen images.
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2.1. Template properties and options

2.1.1. Template fundamental properties

So to optimise the use of this module, CYPE has establi-
shed a series of help proposals to define the job.

The elements to be introduced, such as the columns, exter-
nal outline beams or beams defining openings in panels
should be drawn with different layers.

The external outline beams and opening beams should
form a closed polygon.

It is possible to use a single layer to define the fixed point of
the columns. It will be represented by a closed polygon
containing the point of the column to be defined as fixed.

Each group should be defined by different templates or
layers when a complete template of the job is provided: co-
lumns_grd, columns_flrs, columns_roof, outline_grnd,…

2.1.2. Template options

The Template views manager window can be accessed by
clicking on the icon of the main window toolbar.

Fig. 2.1

To attach the DXF/DWG templates to the project, click on
the button at the top of the window.

The list of imported templates will appear in the dialogue
box.

Fig. 2.2

Upon clicking on the Layer manager, the layers correspon-
ding to the selected template will be displayed. These
layers can be configured: visible or not visible, name
change, colour modification, line thickness edition (if the
thickness is established as By size, it is possible to specify
its value); it is equally possible to leave layer texts visible
and allow object snaps on the entity of a layer.

To the right of the layer list, the results of the layer configu-
ration of the template selected from the above list can be
viewed.

Fig. 2.3

2. Templates
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Once the drawing templates have been imported, the pro-
gram will return to the Template views manager where the
templates will be displayed with their respective layers.

Fig. 2.4

Within the top list of the Template views manager win-
dow, the available views can be seen as well as the Add,
Delete, Copy, Displace, Transformation, Group views,
Open and Save options located at the top.

By clicking on Transformation , a window will open allo-
wing displacements and scaled increases or reductions in
size to be applied to the template. The scaled and displa-
cement transformations can be carried out in two different
ways: manually introducing the value within the Displace-
ment and Scale fields, or graphically by clicking on to
change the coordinates or on to vary the scale.

Once the origin has been displaced, it is possible to return
it to its initial position, in other words, to the original position
of the drawing, by clicking on the icon. This option was
brought about to be able to undo all the changes carried
out on the coordinates using the Change the origin of the
coordinates of a template option .

To change the scale of the drawing when the scale value
is unknown, use the option Adjust the scale of a templa-
te . The program will ask to graphically define the first
and second points of the segment as well as the distance
of the segment with a scale of 1:1.

The option Group views allows to choose for which
groups the templates will be visible.

Fig. 2.5

This option is equally accessible later on by clicking on the
icon . However, in this case, contrary to the option win-
dow Group views, the window that opens only allows to
activate or deactivate the views per floor.

Fig. 2.6

Note: A view is a configuration of layers with the scale and coor-
dinate origin of a DXF/DWG drawing. Generally, it will only be
necessary to create those views required as templates for each
group making up the project. Each view will be related to a tem-
plate and will have a unique selection of layers.
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2.2. DXF/DWG Object Snap
Object snaps can be activated within the Object Snap se-
lection dialogue box, which appears upon clicking on the

icon.

Fig. 2.7

It is equally possible to activate or deactivate the object
snaps by pressing the F3 key. If no object snaps have been
activated, the object snap window will open automatically
upon pressing the key so to select the desired box(es).

If object snaps have already been selected, upon pressing
the F3 key, the object snaps will be activated or deactiva-
ted.

2.3. Drawings and Reports
Within the drawing editor box, the option exists to draw the
DWG or DXF template associated to each floor.

Fig. 2.8

CYPE

25CYPECAD - User manual



3.1. General information on groups
The program allows up to 5 floors per group.

A group is defined as an assembly of one or more equal
and consecutive floors and therefore, will contain the same
reinforcement. Various aspects should be considered for
groups containing several floors:

• Data introduction is the same for all the floors of the
group.

• The results that appear on screen correspond to the
envelope of all the floors belonging to the group.

• The design of all the floors of the group is the same.

• Therefore, a single drawing is obtained for the group,
i.e. a single floor plan, beam drawing corresponding to
a single group, etc.

• It is not necessary to regroup the floors unless a vertical
support (column, shear wall, wall) or sloped beam be-
gins or ends at one of the groups.

3.2. Floor and group introduction
Floor and group introduction is done using the option Flo-
ors/Groups from the Introduction menu within the Co-
lumn Definition tab.

Unless a floor or group has been defined, the only visible
option will be New Floors. Later on, other options will be-
come available. These include: Delete floors, Edit floors,
Edit groups, Join groups and Divide groups.

Fig. 3.1

3.2.1. Creation of new floors

Upon creating new floors, the program will ask whether the
floors to create are to be Grouped or Single.

Fig. 3.2

The number of floors to insert must be indicated, as well as
their heights, live load and dead load (screed, etc.). A more
specific name can also be given to each floor. The use ca-
tegory of the group is also to be indicated. The use catego-
ries are defined separately (explained further down). If the
user has already defined the use categories of the building,
he/she will be able to select the use category for the group
from amongst those that had been defined. On the
contrary, if no use categories have been defined, only the
default option is displayed and the user may modify the use
category of each group later on

3. Groups and Floors
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Fig. 3.3

3.2.2. Use categories

Different use categories can be defined for each floor
group of the structure. Examples of use categories include:
dwellings, shops, warehouses, garages, etc. The number
of use categories the program allows to choose amongst
depends on the selected code. For example, the use cate-
gories for the Eurocode are:

• A. Domestic and household

• B. Offices

• C. Meeting areas

• D. Shops

• E. Warehouses

• F. Vehicle weight <= 30 kN

• G. 30 kN < vehicle weight <= 160 kN

• H. Roofs

For the program, a use category consists of a group of live
loadcases, be they automatic or additional, which combine
with the other loadcases that have been defined in the job
with the same combination coefficients.

This way, the live load combinations for each use category
can be analysed correctly amongst all the use categories
and the remaining loadcases of the job for which different
use categories exist per floor.

The use categories can be selected in the Additional lo-
adcases (special loads) dialogue box within the General
data window (Job > General data > Additional loadca-
ses (special loads)).

Fig. 3.4

The categories that are selected in this dialogue box are
assigned to each floor group in the Edit groups dialogue
box which opens by selecting the Loads menu within the
Beam Definition tab > Loads in groups or in the Co-
lumn Definition tab > Floors/Groups > Edit groups.

If a new job is created using the automatic introduction pro-
cess, the user will have to define the use categories once
the automatic introduction has concluded, then edit the
groups and select the use category. If the new job is being
defined without the automatic introduction assistant (empty
job), the user can choose whether to define the use catego-
ries before or after the groups are defined, in which case if
these are defined after creating the groups, the user will
have to edit them and assign the use categories.
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Fig. 3.5

Different use categories can also be defined for a floor
group. To do so, simply do not introduce a live load for the
group and once the geometry of the floor group has been
defined, introduce the live loads at different positions on
the group, assigned to the corresponding loadcase and
use category.

The user should bear in mind that the more use categories
are defined for a job, the more loadcase combinations the
program will create, and so, the time taken to analyse the
job will be substantially longer.

3.2.3. Elevation of foundation plane

The elevation of the foundation plane can be indicated in
the Edit floors window. The elevations of all the floors are
automatically adjusted to the value given in the foundation.
Within this window, it is equally possible to modify the
names of the floors.

Fig. 3.6

Fig. 3.7

3.2.4. Creation, edition and deletion of groups

To group the floors, click on the option Join groups. This
option will allow to select the floors to be grouped.

Fig. 3.8
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Fig. 3.9

Once this has been done, it is then possible to modify the
properties (names, loads and use categories) of the crea-
ted groups by selecting the option Edit groups. Within the
window, the name of the floors are displayed with the cor-
responding selected floors highlighted in red in the dia-
gram.

Fig. 3.10

Floors belonging to a groups can equally be separated
using the option Divide group.

3.3. Floor and group options
These options can be found in the Groupsmenu within the
Beam Definition tab.

3.3.1. General Options

Copy from another group.
This option allows to copy the properties of a selected
group of floors to the floor that is currently being viewed.
The destination group can be seen in green and the group
to be copied in red (which is selected by moving the cursor
over the group diagram).

Fig. 3.11

Reload group
This option allows to recover the properties from the last
saved copy. Any changes that have been carried out after
the save will be lost. The program will ask to confirm the or-
der before its execution.

Group surface information
This option provides information on the total surface area of
the current group, its beams and floor slabs. The area taken
up by the columns and walls is taken into account within the
total surface area.

Fig. 3.12



Consult floor elevations
Allows to consult the relative and absolute elevations of
each floor.

References
Allows to modify the position and representation of the re-
ferences of different elements. To do so, click on the refe-
rence to be displaced then at its new location.

Show References
Allows to permanently activate or deactivate the references
within the floor view. It is possible to select the texts of
those elements which are to remain visible.

Fig. 3.13

3.3.2. Views

Building section
This option allows for a vertical cut to be made through the
structure to obtain a section view at that cut, which can
then be viewed on the drawings as well as on screen.

There is no limit as to how many sections can be obtained
as long as a name is provided.

Fig. 3.14

Fig. 3.15

All the created sections can then be edited and/or deleted.

Afterwards, in the floor drawings, click on the Building sec-
tions to activate those sections to be visible (the size can
be configured by the user) with the chosen floor plan.

Sections
Lines may be introduced in any direction on the floor to ob-
tain section drawings of the floor and visualise a diagram of
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these sections. When a section line is introduced within
each floor group, a window displaying the section of the
building produced by the line will appear automatically.

Fig. 3.16

3D View Floors
3D view of the current group of floors or the selected inter-
val of groups/floors.

Fig. 3.17

Fig. 3.18

3D View Building
Complete 3D view of the building including, if present, any
integrated 3D structures.

Each construction element (columns, beams, floor slabs
supported by beams, etc.) appears in a different colour
with their respective textures.

The horizontal displacement bar rotates the building about
the z-axis, whilst the vertical bar provides rotation about the
x-axis.

The 3D view has buttons available which allow to pass from
conical projection to isometric projection and vice-
versa.

Whilst the viewed projection is that of the conical projection,
it is possible to move around inside the structure with com-
plete freedom. Within the representation, the floor slabs
and walls are drawn with a degree of transparency to facili-
tate the visualisation of elements that would otherwise be
hidden from view.
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4.1. Definition of columns, shear walls or
starts
To introduce a column, shear wall or start, click on Co-
lumns, shear walls and starts from the Introduction
menu within the Column Definition tab.

Bear in mind that if no floors have been defined, only starts
can be introduced.

Once a column, shear wall or start has been introduced,
the Columns, shear walls and starts menu will contain
more options allowing for them to be edited, displaced, ad-
justed, modify their fixed point, their angle, introduce fixity
coefficients, effective lengths, loads, etc.

Fig. 4.1

4.1.1. Column starts

Starts are columns with zero height which are used to des-
ign the foundations (regardless of them being in the form of
a mat foundation, pad foundations or other) without the
need of having to introduce the whole structure and there-
fore, not having to define floor groups.

Having defined the starts, it will be necessary to introduce
the loads transmitted to the foundations by the columns
using the option Introduction > Columns, shear walls
and starts > Head loads.

Before proceeding with the foundation design, the option
Analyse > Analyse the job from the Column Definition
tab must be selected.

If the foundation has been introduced, then select Analyse
> Analyse the job (including foundation).

4.1.2. Columns

4.1.2.1. New column

When introducing a new column, the initial group, final
group, fixity and buckling coefficients, angle, and external
fixity must be defined.

Fig. 4.2

4. Columns
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The type of column must also be defined for each floor. To
do so, click on the symbol located next to the floor num-
bers in the bottom section of the window. The program will
then ask to choose between a concrete or steel column.
Once the type has been selected, its dimensions must be
defined.

Fig. 4.3

Having defined the properties of the column and clicked
on Accept, the window will close and return to the main
screen where, the position of the columns can be selected
by clicking at the desired position.

4.1.2.2. New column with its start on another column

It is possible define the start of one or more columns on
another column using the option Introduce a column
with its start on another column. This option can be
found within the window that appears upon selecting Intro-
duction > Columns, shear walls and starts.

Fig. 4.4

This option provides more possibilities as to the geometri-
cal disposition of the columns within CYPECAD jobs. For
example, columns may be defined in such a way that, for
different spans, they are adjusted to different fixed points or
have different angles or dimensions which cause part of the
top span to lie within the projection of the column below.

The program allows for an infinite number of spans to be in-
troduced over each other, in other words, a column can be
placed over another which, in turn, is placed over another,
etc. Additionally, more than one column can start on the
same column.

Procedure
Once the option has been selected and the cursor is then
passed over a column, if it changes colour, it is possible to
introduce a column on top. This occurs when the column
ends at a floor that is not the last floor. To introduce a new
column over another, the program draws a concentric cir-
cumference with the axis of the column illuminated (this will
be the base column) on which it is possible to place the
fixed point of the new column.

To position the new column, left click using the mouse. The
program will ask for the coordinates of the fixed point of the
new column with respect to the fixed point of the base co-
lumn. Having introduced the coordinates, a new window
will appear similar to that used for the introduction of the
normal columns, where the new column data will have to
be defined.

It is possible to introduce the top column using DXF or
DWG object snaps to snap to the axis, corners, or mid-
point of the column faces and the faces of the base co-
lumn. In these cases, the program will not ask for the coor-
dinates of the fixed point of the new column.
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Fig. 4.5

Fig. 4.6

For the reference of the new column or columns that start
on a base column, the program uses the same reference
as the base column followed by a letter. The first column will
have the reference followed by the letter <<a>>, the next
with the letter <<b>> etc.

Fig. 4.7

Do not forget that if the columns are not overlapping, the
column is to be introduced in the same way as any ordinary
column and not with this option as it is not a case of a co-
lumn starting at the top of another column.

Option specifications
The fixity coefficient of the top end of the column on which
the new column begins is not affected by the value in the
Fixity coefficient at last floor option (Job > General data>
button By position > button Column options). All those
elements supported by the column (top columns, beams,
slabs…) will be considered as being fixed by default, ex-
cept at the top of the last column span where a fixity coeffi-
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cient different to one is applied (menu Introduction > Co-
lumns, shear walls and starts > Fixity coefficients). It
is equally possible to pin a column reaching a beam or in-
troduce a fixity coefficient other than one at the base of a
new column.

The transmission of forces from the top column to the bot-
tom column is carried out bearing in mind the existing ec-
centricity. The user must evaluate the need to provide a
construction detail to assure this transmission of forces.

It is not possible to modify the external fixity of a new co-
lumn starting on another as it is not possible to have exter-
nal fixity.

4.1.2.3. Column edition

The column options can be modified in the menu Intro-
duction > Columns, shear walls and starts > Edit.
They can be equally modified independently accessing the
options in the Columns, shear walls and starts window.

For example, the fixed point of a column can be modified
directly from the Edit Column dialogue box or using the
option Modify fixed point present in the Column, shear
wall and starts window. This option allows to change the
fixed point of the column keeping the column’s original po-
sition.

Fig. 4.8

Upon selecting this option, a window will open where the
fixed point can be selected. All the columns requiring this
fixed point should then have it assigned to them.

The fixed point of all the columns can be visible whilst intro-
ducing beams and floors by selecting the Fixed point box,

located in the option Groups > Show references in the
Beam Definition tab.

Fig. 4.9

4.1.2.4. Introduction of new columns using data from
another column

Sometimes the case may arise that all or many columns of
a job possess the same properties as one another. For this
case, CYPECAD offers a tool that allows for a new column
to be introduced based on the properties of one that has al-
ready been introduced.

Within the New column window (Introduction > Co-
lumns, shear walls and starts > New column), a Copy
from button can be seen. Upon clicking on it, the New co-
lumn window will close and those columns already introdu-
ced will appear on screen. Once one column is selected,
the New column window will reopen with all the data co-
pied from the selected column.

Fig. 4.10
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The program keeps the data of the last column introduced
when introducing a new column, and so allowing a quicker
introduction in the case of similar or equal columns.

Using the Copy option from the menu Introduction > Co-
lumns, shear walls and starts from the Column Definition
tab, it is possible to copy, as well as the properties that can
be copied using the option Copy from described pre-
viously, the horizontal loads and head loads of the column.

4.1.3. Shear walls

In order to introduce a shear wall, its geometry must first be
defined, which must be composed of rectangles. Other
data to be indicated includes: a name for the wall, its initial
and final group, followed by, in other windows, its thick-
ness, external fixity and angle.

Once all the windows have been accepted, the wall can be
introduced at the desired point. The types of shear walls
created are saved with the job and so can be introduced at
any time with no limit as to how many.

4.1.4. Column minimum geometric ratios

For each code and depending on the selected steel, there
are minimum values for the geometric ratios of the co-
lumns. These values are usually those applied by the pro-
gram for column design and verification. Nonetheless, if
other values are required, it is possible to introduce them:
Job > General data > By position > Vertical bar op-
tions > Minimum geometric ratios for static and dyna-
mic loading. These user values will substitute the minimum
ones from the code.

Fig. 4.11

4.2. Column results

4.2.1. Column design

Once the job has been analysed, those columns not pas-
sing all the code checks will be displayed in red. They
should be verified using the option Columns > Edit loca-
ted in the Results tab.

Having selected this option, click, using the left mouse but-
ton, on the column whose errors are to be consulted and a
window will emerge entitled Column design.

Fig. 4.12

4.2.1.1. Concrete columns

If several columns contain design errors, the following mes-
sage will appear in the analysis report: “Columns (…) have
a design error. They must be reviewed using the option Co-
lumns > Edit”. The column section is also displayed in red
on screen at the floor at which the error is located.

Column errors
Within the Column design window, those column spans
containing errors will have a warning symbol displayed on
the left. A status column can sometimes be viewed dis-
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playing letters, whose meaning is detailed below. Upon
clicking on them, details of the check as well as advice on
how to solve the errors is displayed.

Fig. 4.13

• SAe: Excessive ratio
The program considers the mechanical percentage
between the concrete and the steel in the columns
should not be greater than 100% and that the geome-
tric percentage should not overcome 8%. If these va-
lues are exceeded, the letters SAe are displayed.

• Ve: Shear failure
The program checks that the shear force does not ex-
ceed the force that would produce oblique compres-
sion failure of the section in reinforced concrete co-
lumns and for those cases where it is stated in the se-
lected code. When shear reinforcement is necessary,
the program also verifies the spacing required.

Upon clicking on the button, a window appears indica-
ting the longitudinal area in the X and Y directions, the
reinforcement area of the stirrup, the forces in both di-
rections as well as the resisted shear force in each di-
rection.

The verification controls that:

Where:

Vsd = the design shear force to which the columns section
is submitted in each direction
Vrd = Resisted shear force by the column section in each
direction

• Sot: Stirrups outside table
Only one stirrup is placed. Review the column reinforce-
ment table and the layout of the stirrups when creating
the required types for the reinforcement and dimen-
sions of the existing columns.

• Vr: Volumetric ratio of stirrups
In the case of earthquake loading with very high ducti-
lity, the confinement geometric percentage is limited.
This percentage is the ratio between the mechanical
percentage of the stirrups and that of the concrete, per
metre length of the column.

• fr: Fire resistance check
The program indicates if the section fails the fire check
according to what was specified by the user.

• As/Ac ratio

Within the Column design window, located in a column
on the right is the ratio of the steel section to the
concrete section expressed as a percentage.

4.2.1.2. Steel columns

If there are steel columns in the structure, a window offering
design options will appear. If the program is to design the
steel sections, the manner in which they are to be designed
must also be selected.
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This includes indicating to the program whether it can des-
ign the section using all the sections of the series or using
sections greater than the current section. In the first case, if
the program finds a smaller section capable of withstan-
ding the forces, this section will substitute the existing sec-
tion. In the second case, CYPECAD will only use sections
that are greater or equal to the chosen section.

Fig. 4.14

In the Column design window and when dealing with steel
columns, a new option: Check series appears. This op-
tion allows to replace the current column with another and
carries out an immediate check on the result of the change.

Fig. 4.15

In the windows that opens, the line weight of the sections is
displayed as well as the ratio (%) of the resisted force to the
design yield strength (elastic limit) and if there are any des-
ign errors.

Fig. 4.16

The Optimum section button restores the proposed des-
ign section if it has been modified by the user.

4.2.1.3. Column data

By clicking on this button (located in the Column design
window), the following information is displayed: angle, fixity,
support elevation change and depth of support.

Fig. 4.17
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4.2.1.4. Column layout

This button provides a layout of the columns of the selec-
ted or selected floors. If there is a column that has not been
designed, (manual reinforcement), it will be displayed in
red.

Fig. 4.18

The column selected from the Column design window is
marked with a yellow circle. By clicking on another column,
the yellow circle will appear on that other column and if the
Column layout window is closed at this point, the column
displayed in the Column design window will be the newly
selected column.

4.2.2. Block column reinforcement

The option Block reinforcement allows for the structure to
be re-analysed without modifying the column reinforce-
ment. This tool is located in the Column menu within the
Results tab.

4.2.2.1. Things to consider when using this option

The Block reinforcement option has been brought about
so not to loose the manual modifications that have been
carried out on the column reinforcement upon re-analysing
the structure.

When re-analysing the job, the program will carry out a
check on all the blocked columns ensuring that all the
conditions of the selected code are met. Those failing a
check will be displayed in red.

If significant errors appear in a blocked column after a new
analysis, they imply that the changes undertaken on the job
after the reinforcement has been blocked, substantially af-
fect the columns. It is therefore recommended the column
reinforcement be redesigned.

There are two options to redesign the columns: unblock
them and then redesign (Beam Definition tab, Analyse
> Redesign columns) or keep the columns blocked and
use the Redesign option in the Column design window of
each column (Results tab, Columns > Edit).

When modifications have been carried out implying an in-
crease or decrease in the number of floors supported by a
blocked column, the program will automatically unblock it.

Unlike what occurs with blocked frames, the program un-
dertakes a complete code check on all the blocked co-
lumns. Therefore changes made to the structure after
blocking the column reinforcement are not as conflictive.

The blocking of columns is a very useful tool to have for dif-
ferent project situations, for example, to study how the co-
lumn reinforcement varies depending on the applied fixity
coefficient; subgrade modulus; jobs with mat foundations;
etc.

This option is only applicable to reinforced concrete co-
lumns, the equivalent option for steel columns can be pro-
duced if, upon selecting to analyse the job, the Design
steel sections box is left unmarked.
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4.2.2.2. Procedure

Once the Block reinforcement option from the Columns
menu is selected, the Block reinforcement window will
appear.

Fig. 4.19

Within this window, it is possible to select the desired co-
lumns one by one using the left mouse button. It is equally
possible to use a capture window to select several co-
lumns at once. At the top left hand corner of the window,
there are two buttons allowing for all the column reinforce-
ment to be blocked or unblocked at once. Instructions on
how to proceed blocking or unblocking the columns are
displayed at the bottom of the window.

Selected columns will appear in green. If there are steel co-
lumns, they will appear in grey and cannot be selected.

The dialogue box must be accepted for the selection to be
effective.

4.2.3. Force diagrams

Within the Envelopes menu in the Results tab, the option
Forces in columns and shear walls can be found. These
options allow for force envelopes to be consulted (Mo-
ments, Shear and Torsion), by loadcase or loadcase com-
binations.

Fig. 4.20

4.3. Drawings and Reports

4.3.1. Drawing options

4.3.1.1. View of the fixed point in the drawings

It is possible to configure drawings to show or hide the
fixed points of columns. Upon pressing the Configure but-
ton in the Drawing editor window and then selecting the
Columns tab, the Fixed point box can be selected or un-
selected.

Fig. 4.21
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4.3.1.2. Column stirrup options

To take the indicated considerations for the stirrups (Job >
General data > By position > In columns, walls
and corbels > Options for stirrup reinforcement) into
account, there is an option, allowing to draw, within the co-
lumn schedule drawings, a detail displaying these condi-
tions, and therefore avoiding errors onsite.

Fig. 4.22

This option can be activated in the Drawing editor dialogue
box (File > Print > Job drawings > Add or Edit
Column schedule).

4.3.2. Report options

Within the report Forces and reinforcement of columns
and shear walls and walls is the option Shear resistan-
ce check in reinforced concrete columns in which the
shear forces are indicated for the columns of the job.

Fig. 4.23

CYPE

41CYPECAD - User manual



5.1. Wall introduction
Wall introduction is done by selecting Beams/walls > De-
fine wall from the Beam Definition tab. A floating dia-
logue box will appear from which the type of wall (a reinfor-
ced concrete wall, a NORMABLOC wall, a reinforced
concrete block wall or a masonry wall) is to be selected.

Fig. 5.1

5.1.1. Floating menu

Upon selecting the option Beams/walls > Define wall
from the Beam Definition tab, a floating menu will appear
in which the introduction options belonging to the different
types of walls are located.

For all the types of walls (reinforced concrete, block or ma-
sonry walls) a window appears allowing the geometry of
the wall to be defined as well as indicating whether or not
there are lateral pressures present and what type of foun-
dation it will rest on.

Generic blocks or NORMABLOC blocks can be used for
block wall introduction. The dialogue box that is visible on
screen contains options that are common to both types of
walls and one option exclusive to NORMABLOC walls.

5.1.2. Wall types

5.1.2.1. Reinforced concrete walls

5.1.2.2. Generic reinforced concrete block walls

The block wall dialogue box contains a field in which it is possi-
ble to select what type of blocks the wall is to be made out of.

It is possible to choose a block from the program’s library
or introduce different blocks in the library. These operations
can be undertaken using the selection buttons and tools
present using the Block field.

Fig. 5.3

Fig. 5.4

5. Walls
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Within the generic block walls, Series editor window, it is
possible to activate the With corner element box. The
corner elements are to be used when the width of the block
is not equal to half its length. This way, the special corner
elements allow for a faster construction of the wall.

5.1.2.3. NORMABLOC walls

Prefabricated concrete walls are a traditional solution due
to their properties. They can act as load bearing walls (re-
sisting horizontal and vertical loads) as well as providing
partitions or enclosing spaces where required.

It is possible to design and check existing concrete blocks
(and those of manufacturer companies as in the case of
the Spanish group NORMABLOC: National Association of
Masonry and Concrete Block Manufacturers), optionally
provide vertical and/or horizontal reinforcement, all this res-
pecting the criteria imposed by Eurocode 6 (Masonry des-
ign and construction. Part 1-1. General – Rules for reinfor-
ced and unreinforced masonry). Provision of analysis re-
ports, takeoff and floor drawings as well as a diagram on
plan of the blocks and their reinforcement.

In the case of NORMABLOC blocks, it is only necessary to
select, using the option Block from the dialogue box, the
manufacturer and the type of block to be used.

Fig. 5.5

Fig. 5.6

NORMABLOC walls do not have the option With corner
element, although the program is aware if the manufactu-
rer and selected block model have these special elements
available and will use them, if necessary.

5.1.2.4. Masonry walls

This option allows generic walls to be introduced.

Within the General data window of the Job menu and
upon selecting the wall icon , it is possible to define the
modulus of elasticity, shear modulus, unit weight, design
compressive strength, design tensile strength and whether
or not to consider shear stiffness, required in the case of
masonry walls resisting horizontal shear (produced by hori-
zontal loads) and tension (in the case of walls supported by
floor slabs and connected to higher floors).

Fig. 5.7
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5.1.3. Wall openings

5.1.3.1. General

By selecting the option Beams/Walls > Wall openings in
the Beam Definition tab, a floating menu will appear allo-
wing windows and doors to be introduced in reinforced
concrete, generic masonry and reinforced concrete block
walls.

Fig. 5.8

To introduce the openings at their correct positions, the
floor viewed on screen must be the lower of the two floors
between which the window or door is located. For example,
if a door is to be introduced in a wall between floors 1 and
2, the introduction floor must be floor 1.

In the case of openings in concrete block walls, when using
the Wall openings option, it is possible to adjust the ope-
ning within the block distribution of the wall. This way, the
dimensions and position of the opening will adjust them-
selves to the length of the block so to avoid having to pro-
vide special pieces.

Fig. 5.9

For a better understanding of this option, please read the
generic and specific help dialogue boxes that appear in the
Wall openings introduction process.

When openings are introduced in basement walls and ge-
neric masonry walls, the program does not warn of the ex-
cessive constraints in the lintel area. On the other hand, in
the case of concrete block walls, this check is carried out
and the lintel reinforcement is designed.

5.1.3.2. Opening reinforcement

Upon clicking on the option Wall openings from the Be-
ams/Walls menu within the Results tab, a floating menu
with the following options will open:

Fig. 5.10

• Edit. Allows to edit the reinforcement of the door or win-
dow. If the opening is approached by the cursor, it will
be highlighted in yellow and can be edited by clicking
on it.

Fig. 5.11

• Assign door reinforcement. By clicking on this op-
tion, the Assign reinforcement to wall openings win-
dow appears in which the reinforcement can be defi-
ned. Within this window, the Select button can be
found, which allows to choose the reinforcement of a
specific door opening, and the Assign button, allowing
for all the doors which are to possess this reinforcement
configuration to be selected.

Fig. 5.12

CYPE

CYPECAD44



• Assign window reinforcement. Same as the previous
option except only the window reinforcement can be
edited.

Fig. 5.13

• Assign lintel reinforcement in concrete block
walls. Works in the same way as the previous options,
however in this case, it is only possible to assign rein-
forcement to concrete block wall lintels.

Fig. 5.14

• Verification of the reinforcement at wall opening
level. Activate this option and select the wall opening
whose reinforcement is to be checked. The report of
the assessed checks will appear.

Fig. 5.15

5.1.3.3. Opening reinforcement design

During the reinforcement design process of concrete walls,
the reinforcement of the openings (windows and doors) wi-
thin the walls is designed. This reinforcement is designed to
support any lateral pressures, forces at door and window
lintels and at window sills.

For those cases where the wall is subject to seismic loa-
ding and the acceleration is greater than 0.16 g, inclined
reinforcement is laid in the lintel and sill.

If the ratio
Free opening span

________________________
Lintel width

is less than 1.5 and the tension in the beam is greater than
the tensile resistance of the concrete in compression, the
beams containing the frame will constitute the inclined rein-
forcement.

5.1.4. Extend walls

This option, accessed by clicking on Beams/Walls > Ex-
tend wall in the Beam Definition tab, works in the same
way as the option used to extend beams. The wall is exten-
ded in all the floor groups in which it has been defined.

5.1.5. Assign walls

This option is located in the Beams/Walls menu in the Be-
am Definition tab. This option allows to select a wall and
assign its properties to another wall or to a series of walls
selected using a capture window.

When executing this option, a type of wall must be chosen
from the floating menu. A dialogue box will then appear
describing the properties of the type of wall that has been
selected.
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In this window, the properties to be assigned can be modi-
fied or copied from a wall that has already been introduced
using the Select button. Using this button, it is possible to
select walls of a different type to that which was chosen
from the floating menu. With the Assign button, the pro-
perties displayed in the previous window can be assigned
to an already existing wall. The assigning of a wall or pro-
perties can be done individually or to several walls by
means of a capture window.

5.1.6. Edit walls

Beams incorporated in walls and crown beams are visible
on plan superposed with the wall. The option Edit from the
Beams/walls menu is used to edit the introduced data of a
beam or wall.

5.1.7. Design options

Options for wall reinforcement are located in Job > Gene-
ral data menu and are accessed by pressing the wall icon

.

Fig. 5.16

These options allow to define:

• The type of steel for the horizontal reinforcement in
block walls.

• Resistance properties of the mortar and blocks to be
used in NORMABLOC walls.

• Reinforced concrete wall reinforcement design options:

a. Whether or not to use reinforcement

b. Always provide reinforcement or only when neces-
sary

c. Only provide horizontal reinforcement or horizontal
and vertical reinforcement.

d. Type of horizontal reinforcement.

5.1.8. Column disconnection in masonry and
concrete block walls

Columns in contact with masonry or block walls are separa-
ted from the wall at floor level. This allows the program to
obtain a more realistic force transmission for those columns
integrated within the walls.

For each column that is contact with a strip footing, it is
possible to design an equivalent pad footing.

The forces used to design the pad footing are those rea-
ching the foundation via the columns and the parts of the
wall supported by the footing.

5.2. Drawings and reports
5.2.1. Reports of block walls
The block wall takeoffs detail the number of complete ele-
ments and special elements such as half blocks or angle
elements.

Fig. 5.17
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6.1. Beam introduction manager
The introduction of the outline of a floor can be accompli-
shed more quickly using a DXF or DWG template in combi-
nation with the various beam introduction tools.

The information indicated in the following pages is available
in the generic help windows in the program and the speci-
fic help windows that appear during the introduction.

6.1.1. Beam introduction menu

Upon selecting Define beam from the Beams/wallsmenu
in the Beam Definition tab and accepting the dialogue re-
questing the type of beam section, a floating menu will ap-
pear containing the following options:

Fig. 6.1

Current beam selection
The first icon of the dialogue box opens the beam selection
window to change the type of beam to introduce.

Fig. 6.2

The other icons represent the tools for beam introduction.
All are located within this small window and many have di-
rect access icons so to avoid having to displace the mouse
in order to use these tools during the beam introduction.

Continuous and discontinuous beams
This option allows for simple or continuous beams to be in-
troduced.

Fig. 6.3

• Continuous mode

The final point of one beam is the initial point of the
next. To finish off the introduction of a series of beams,
click on the right mouse button and select option Fi-
nish introduction from the emerging menu. While this
option is not selected, the introduction of the beam in
continuous mode will not be effective.

There are more options in the mentioned menu. Some
of these are accessible with a quick key:

- Finish introduction: Ctrl + T
- Delete last point: Ctrl + B

• Simple mode

When the final point the beam is marked, another does
not begin. If another beam is to be introduced, its start
point will have to be marked, which does not have to
coincide with the end point of the previously introduced
beam.

6. Beams
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Adjustment of the beam
This option allows for the beam to be adjusted to along its
central axis or to one of its sides, in other words, change
the adjustment line of the beam.

Fig. 6.4

To understand this definition, two concepts used in the pro-
gram must be explained:

• Adjustment line of the beam. This can be the axis or ei-
ther edge of the beam. It is the reference line used by
the program from which the distance is measured to
the introduction line. This distance is indicated in the
Move option.

• Introduction line of the beam. This is the line that is mar-
ked with the mouse pointer during the introduction of
the beam. The Adjust andMove options vary the posi-
tion of the beam relative to the introduction line.

Changing the adjustment line can be done equally with the
shortcut. Similarly, if the adjustment is to be changed du-
ring the introduction of the beam, all that has to be done is
displace the mouse to the beam introduction menu. By
pressing Ctrl + E, the adjustment type will change cycli-
cally.

Beam displacements during the introduction
This option establishes the distance between the introduc-
tion line and adjustment line defined in the previous para-
graph.

Fig. 6.5

The use of the option is helpful in the following case: the
edge of the beam limiting the floor slab is, generally, shifted
a few centimetres due to coatings or other elements of the
façade. Usually, the lines drawn on the DXF or DWG tem-
plates are those representing the façade outline and not
the structural floor slab limits. In all cases, the introduction
line will not coincide with the adjustment line and will lie out-
side the width of the beam.

Straight and curved beams
The shape on plan (straight or curved) of the beam to be in-
troduced can be selected here. Upon clicking on this but-
ton, the four available options appear (unless the simple
beam option is activated, in which case, only the first two
options will be visible).

Fig. 6.6

• Straight beams. The initial and final points of the beam
have to be marked using the left mouse button.

• Curved beams. Using the left mouse button, three
points have to be marked defining the initial, pass-
through and final points of the curve. By pressing Ctrl +
A, the beam introduction changes from curved to
straight and vice versa. What the program is really dra-
wing is a series of straight beams forming a polygon
adjusted to the outline of the circumference defined by
the three marked points. With regards to the introduc-
tion and adjustment lines, these work in the same way
as in the case of straight beams, except that in this
case, they can be considered as curved lines.

• Alternate introduction of straight and curved beams.
When the continuous beam introduction is activated, a
beam following the same shape can be introduced or
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straight and curved spans can be alternated. Two op-
tions appear in the menu: one beginning with a straight
span and another with a curved span. This option can
also be accessed using Ctrl + A.

6.1.2. Beam types

When introducing a new beam, the Current beam window
opens where the type and properties (dimensions, section,
shear studs, etc.) of the beam must be chosen. The follo-
wing beam types are those that available in CYPECAD:

Flat beams
Flat beams are those possessing a thickness equal to the
elevation difference between the highest and lowest points
of the floor slab they form the outline of.

Dropped beams
Dropped beams can be rectangular, T-shaped and with a
contributing compression head. In the latter case, the
flanges contribute to the stiffness of the beam, but, for rein-
forcement calculations, only the web is used. This is a
common way to model flat slabs framed by dropped
beams.

Latticed and prestressed beams
The properties of latticed and prestressed beams are defi-
ned by clicking on the icon that appears in the top right
corner of the selected window.

External fixity beams
External fixity type beams can simulate, for example, the
top of a wall. If the path of the walls coincide with the co-
lumns, they must be disconnected using the option Be-
am/Walls > Pin/Disconnect so that the vertical move-
ment of the columns is not restrained by the walls. Note
that walls may only be disconnected from columns in joist

slab systems since flat slabs or waffle slabs cause the load
descending from the column to spread out onto the wall
and so not all the load is transferred down the column. If
this problem is encountered, it is recommended that the
wall support be eliminated and the wall be introduced using
the option Beams/Walls > Define wall.

The crown beam at the top of the wall cannot be specified
with the program. Consequently, the user must provide a
construction detail with the dimensions and minimum rein-
forcement for this element. Consult the construction details
library supplied with the program.

Non-structural or limit beams
This option is used to define the outline perimeter for a solid
slab panel when the influence of the edge beam with res-
pect to the force resistance is negligible or is not to be
considered. Its function is simply to limit the border of the
panel. On site, if a beam is to be used to carry out this func-
tion, a generic edge beam detail of the beam to be used
should be provided.

Foundation beams
Foundation beams can be rectangular, L or T, or flat beams
(the latter are used to close off panels in mat foundations).

Steel and composite beams
• Steel beams. Steel beams can be introduced as com-

posite beams, welded in a box, separated with batten
plates or joined, etc. The same section library is availa-
ble as for steel columns.

Castellated steel non-composite beams can be des-
igned and verified. Within the Layout drop down menu
in the Description dialogue box, the Castellated (web
openings) option can be selected. Upon doing so, a
dialogue box will open in which the properties of the
beam can be selected as well as the shape of the ope-
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ning (hexagonal, octagonal or circular), the dimension
ratios and the number of filled openings at the ends of
the beam.

• Composite beams. It is possible to introduce (type 1)
steel sections below the floor slab with a contributing
concrete head by means of shear studs, whose geo-
metry can be defined.

A partial fixity coefficient of 0.05 is applied to the
connection of the composite beam with its support (in
the same way as the column heads of the last floor)
with the aim to reduce the negative moment and in-
crease the positive moment.

Composite beams are designed so that in the negative
moment zone, the steel section resists all the forces
and in the positive moment zone, the composite sec-
tion withstands the forces.

With regards to the moment calculations; it is not ne-
cessary to indicate the width of the contributing
concrete section. The program takes the minimum bet-
ween the calculated effective width and the width of the
flange plus 10 cm for each side, if it does not consist of
an edge beam, otherwise, the program calculates the
width of the flange plus 10 cm.

To verify the positive moment sections, the effective
width is different to that taken for the bending analysis.
Therefore, in the beam editor, the width that appears is
that of the effective width in the negative moment zone
in case reinforcement is added at the supports, which
is not designed by the program in the present version.

6.1.3. DXF or DWG object snap during beam intro-
duction

It is possible to adjust the beam with any of the DXF or
DWG object snaps available (nearest, intersection, end,
mid-point, etc.) The adjustment is carried out during the in-
troduction of the points making up the simple or conti-

nuous beams and this is why it is not necessary to use a
second option (Adjust) to place the beam at its final posi-
tion.

6.1.4. Polybeams

This option can be found in the Beams/Walls menu from
the Beam Definition tab.

For CYPECAD, a Polybeam is an assembly of consecutive
beams grouped in such a manner that if one undergoes a
geometrical change, all the others in the group will also
change. In a similar way, if one beam of the assembly is de-
leted, all the others will also be deleted. Nonetheless, the
reinforcement of each beam can be different.

This option has great similarity to that of the curved beam
introduction option. A curved beam is composed of several
straight beams that change direction. If the properties of a
curved beam are to be changed, each of the straight
beams must be modified individually. To simplify the pro-
blem, it is best to group the straight beams and make a
Polybeam.

Even though it is not always useful, the Polybeam option is
in most cases. This is because the Polybeam option al-
lows for other options to be used to vary the groups regard-
less of it being straight or curved.

The beams forming a curved beam are by default grouped
as a Polybeam. Using the Polybeam option from the
Beams/Walls menu, the beam can be decomposed or
modified. The beams forming a curved beam are by de-
fault grouped according to a Predefined reinforcement
span. This option, present in the Beams/Walls menu, also
allows to decompose the group.
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6.1.5. Predefined reinforcement spans

A Predefined reinforcement span is composed of an as-
sembly of consecutive beams in which the bottom reinfor-
cement does not overlap at an intermediate point of the
group. This will be applied for every group of beams whilst
the length of the steel bars do not exceed the maximum
bar length established in the program options.

The reason for the existence of Predefined reinforcement
spans is the same as that given previously to justify the
existence of Polybeams. This allows to simplify beam rein-
forcement construction.

Even though the Predefined reinforcement spans option is
useful in most cases, it is not always. This is because the
Predefined reinforcement spans options can be decompo-
sed into various options allowing to vary the groups regard-
less of the beam being straight or curved.

The composition or decomposition of the Polybeams and
Predefined reinforcement spans, which imply a change in
the number of beams making up the alignments (frames),
is useful to view the designed reinforcement. In order to ob-
tain the new reinforcement, it is only necessary to redesign
the frames using the options in the Analyse menu.

6.1.6. Sloped beams

For steel or concrete sloped beams. It is possible to gene-
rate a beam for each floor between the selected initial and
final floor groups.

Fig. 6.7

• Simple. The program generates a single sloped beam
between the selected initial and final floor groups.

• Multiple. A sloped beam is generated for each floor bet-
ween the selected initial and final floor groups.

Fig. 6.8

6.1.6.1. Diagonal braces

Using the option Beams/Walls > Sloped beams > Add
diagonal braces, diagonal braces can be introduced and
then carry out other operations with them.

Fig. 6.9

The window contains the following options:

• Initial and final group. Floor groups at which the
brace begins and ends. These groups should have a
single floor. Nonetheless, the diagonal brace can go
through intermediate groups containing more floors.
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• Simple. The program generates a single diagonal
brace between the selected initial and final groups.

• Multiple. A diagonal brace is generated at each floor
between the selected initial and final groups.

• Type. If a simple beam is selected, the user must indi-
cate whether it is a concrete or steel beam. If a
concrete beam is chosen, the width and depth of the
beam must be specified, otherwise, the steel section to
be used must be selected from the section library. In
the case of a steel beam, a further option is provided
whereby it may be placed transposed or upright.

• Connection at ends. It is possible to indicate whether
the connection at the ends of the brace is a fixed or
hinged connection.

• Buckling coefficients. These are required for sloped
steel beams or for steel diagonal braces. The coeffi-
cients introduced are multiplied by the complete length
of the beam between nodes. Therefore, in the case of
two sloped beams intersecting at a point, the program
will not take this intersection into account.

The vertical and transverse buckling coefficients are es-
tablished with respect to a vertical plane containing the
bar and the Z axis of the structure and its transverse
plane, not in the local axes of the bar.

• Copy from. If the user wishes to introduce diagonal
braces based on others that have already been introdu-
ced previously on screen, click on this option. Having
done so, click on the diagonal brace to be copied and
the window containing the properties of the selected
brace will open.

• Add. Allows to introduce a diagonal brace. The two
end points of the diagonal have to be indicated for its
introduction. For example, click on a beam from which
one of the diagonals starts and then on the opposite
beam, where it ends. Upon carrying out this operation,
an automatic floor jump is not produced, only the floor

at which the diagonal starts at is left on screen. The
braces drawn on screen may look horizontal, but this is
not the case. Two arrows are drawn within the bar indi-
cating each diagonal.

As additional information regarding diagonal braces, it
is convenient to know that a node is generated at the in-
tersection of the diagonals and that these are designed
for tension as well as for compression. For this reason,
they generally present a slenderness problem, given
that the program verifies that the slenderness of the bar
does not overcome the maximum slenderness (defined
in the code) for those elements in compression.

Once a diagonal brace has been introduced, new op-
tions will appear in the Sloped beams dialogue box:

Fig. 6.10

• Delete. Deletes the selected diagonal brace. In the
case of the generation being multiple, they are deleted
in all the groups.

• Information. It is possible to know the type of diagonal
brace, the initial and final groups, real length, type of
section, connections and buckling. The result is also
drawn on the beam drawings of the group correspon-
ding to the initial group.

• Edit. Allows to modify the data introduced for the dia-
gonal brace. When editing the diagonal brace, regard-
less of whether or not it was a multiple introduction, it is
only edited in the current group.

• Move. Allows to displace the ends of a diagonal brace.
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When displacing the diagonal brace, regardless of
whether or not it was a multiple introduction, it is only
displaced in the current group.

• Assign diagonal braces. This option allows to copy
the properties of a diagonal brace to one or more dia-
gonal braces that have previously been introduced. The
window that appears is similar to the Add diagonal
braces window, except that in this case, as it has been
explained previously, its function is to modify the pro-
perties of beams that have already been created. Upon
assigning a diagonal brace, regardless of whether or
not it was a multiple introduction, it is only assigned in
the current group.

6.1.7. Common beam

6.1.7.1. Create common beam

This option gives a beam that have been previously intro-
duced in a group of floors, the property to exist in another
group. This is the case for example, of a perimeter beam
supporting a horizontal slab which meets an inclined slab.
The beam supporting the slabs is a Common beam. The
beam is only introduced in one of the two groups. Select
this option and click on a beam; the program will then ask
for the common group to be selected. On doing so, the
beam will automatically be created in the group. The axis of
this type of beam is drawn with a discontinuous dash-dot
line. To undo a common beam, it is first recommended it be
deleted from the associated floor group, if not from the
group in which it was first introduced.

The reinforcement and envelopes must be consulted in the
group in which the beam was introduced.

It is possible to create a common beam for half the length
of the beam, by selecting either end of the beam. Each part
can be common to different groups.

6.1.7.2. Undo common beam

Option Beams/Walls > Common beam > Undo com-
mon beam. Splits a common beam into the two original
beams. This must be carried out on the associated beam.

6.1.8. External edge beam introduction

The option Beams/Walls > Define rectangular external
edge allows to introduce a beam forming a rectangular
outline outside the current perimeter of the floor. The com-
mand contains a further two options. Upon choosing either
of them, the Current bema window will open to allow the
user to select they type of beam to be introduced.

• Introduce rectangular external edge with 0 angle.
The two opposite corners of the rectangular opening
must be selected (the sides of the rectangle must be
parallel to the general axes).

• Introduce rectangular external edge with any an-
gle. Two corners of one side have to be indicated follo-
wed by a point on the opposite side.

6.1.9. Assign beam and wall options

The Assign beams option within the Beams/Walls menu
in the Beam Definition tab allows for the properties of the
last beam introduced (or that selected as the current beam)
to be copied to previously introduced beams. The beam
onto which the properties are to be copied can be selected
in several ways by means of a capture window.

The same option is available for walls using the option As-
sign walls.
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6.1.10. Extend beam

This option allows for the beam to be extended a fixed
length or manually at one end. By selecting the Fixed
length option box, introducing the length and then accep-
ting, upon approaching the cursor to the end of the beam
in question, the extension of the beam will be displayed. By
clicking the left mouse button, the extension will be confir-
med. Alternatively, the beam end in question can be exten-
ded manually by not selecting the Fixed length option box,
accepting, then clicking on the end and dragging it using
the mouse to the desired position, finally confirming with a
click of the left mouse button.

6.1.11. Corbels

These allow for a beam to be supported on a column indi-
rectly to represent expansion joints. They should not be
used as column supports.

6.1.11.1. Corbel introduction

The following steps should be followed in order to intro-
duce a corbel.

1. First introduce a regular beam up to the face of the co-
lumn.

2. Select the corbel to be introduced and define its type
and geometry (the dimensions of the support area
must also be specified here).

3. Click on the face of the column or columns in question.

At the centre of the support, the program will internally
place a fixed support in such a way that the beam conti-
nues up to the support and only the vertical load is trans-
mitted to the corbel. The beam is automatically disconnec-
ted from the face of the column (any shear or moment is
not transmitted).

6.1.11.2. Corbel edition

This option allows for the corbels to be modified.

6.1.12. Corbel adjustment

By clicking on the right mouse button, if sloped planes have
been introduced previously, an option appears allowing for
the beams to be adjusted to the intersection of the sloped
planes or the maximum slope line. The adjustment of the
planes to the intersection is necessary so to ensure the axis
of the beam separating two floor panels, of which at least
one is a sloped plane, coincides with the intersection of the
planes of these floor panels. This intersection is represen-
ted by a continuous magenta line if it does not find any
beam axes and a discontinuous magenta line in the oppo-
site case. The axis can be adjusted to the maximum slope
line, in which case, it will be represented by a continuous
magenta line on the beams belonging to the sloped panels
where the direction is not parallel to the maximum slope
line. This line passes exactly through the centre of the
beam (relative to its thickness and width). To adjust the
beam, it must be clicked on.

6.1.13. Beam reinforcement within walls and crown
beams

The possibility exists to optionally reinforce the beams at
floor panel level and generic masonry walls and concrete
block wall crown beams. In the case of basement walls, the
beam is reinforced at the top of the wall.

In the window Beam reinforcement within walls and
crown beams located by clicking on Job > General data
> By position > Beam options, it is possible to indicate
whether or not to reinforce the beams for the different types
of walls. The minimum thicknesses of these beams should
also be indicated.
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Fig. 6.11

To understand how the option works and know in advance
the dimensions of the beams that are going to be placed,
consult the help options available in the window.

6.1.14. Effective slab width when using steel beams

The Information option from the Beams/Walls menu in
the Beam Definition tab allows for, amongst other things,
to know the effective width of the slab supported by the
steel beams.

6.1.15. Beam reinforcement editor configuration

It is possible to define the covers within the confinement
zones (only when the analysis has been carried out with
earthquake loading and all the reinforcement has been pla-
ced on site). In this case, vertical blue lines appear.

Fig. 6.12

6.1.16. Beam joint and portal frame base references

Allows the user to save the particular base references to be
used for future jobs.

An option exists for the beam joints and another for portal
frames. These are located within the menu Job > General
options > By position > Beam options.

Fig. 6.13

Fig. 6.14

6.1.17. Template object snap for beam introduction

This option is only available to those users possessing the
Automatic job introduction module. This allows, based on a
single click, to introduce a series of beams adjusted to a
template entity.

Once this option has been selected, if the cursor of an en-
tity (line, arch or polygon) is placed close to the template,
the beam to be introduced will appear automatically. This is
then adjusted at its face or axis. If the cursor is situated to
one side of the entity which is going to be snapped to, the
beam is displaced in the direction of the cursor, that is to
say, the adjusted side is that opposite to the cursor. If the
cursor is situated exactly on the entity to be snapped to, it
is adjusted to its axis.

In both cases, to validate the introduction, click on the se-
lected position.
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6.2. Beam analysis and results

6.2.1. Steel beam design within the analysis menu

If there are steel beams within the structure, a window ap-
pears displaying the design options available. If one or
more of the options are chosen, the design process to be
followed must be selected.

An initial section size will be selected from the tables. The
program will prompt whether the design is to be carried out
using sections greater than that initially used in the job or
from the first section size in the table. In the first case,
CYPECAD will only design those sections greater or equal to
that selected. In the second case, if a smaller section exists
that can resist all the forces, this will be used instead.

Fig. 6.15

6.2.2. Beam errors

Stirrup diameter greater than the thickness/10. In the
NB-1-200 code the maximum diameter of the stirrups is li-
mited. If the result exceeds this limit, the program will emit
a warning.

Change in elevation requiring special detail. For those
beams with a longitudinal elevation change, it is necessary
to provide a construction detail indicating the additional

stirrups of the elevation change beam to ensure continuity
of the longitudinal reinforcement of the beam for both ele-
vations.

Length of the bar greater than the maximum length.
This error arises when the program cannot divide the bar
and the resulting lengths exceed 12 m.

6.2.3. Sloped beams

Having analysed, a report appears indicating the errors in-
curred upon analysing the sloped beams.

The following options are located in the Beams/Walls
menu in the Results tab.

Fig. 6.16

Information. This option allows to obtain the properties
(types, initial and final floors, section or dimensions and
reinforcement, fixity, buckling) of the selected beam.

Efforts. Provides a list of materials, descriptions and forces
by loadcase, combination forces, force envelopes, usage
coefficient in the case of steel beams, design results (or
reinforcement in the case of concrete beams) and lastly,
any design errors.

Errors. Sloped beams containing errors or problems are
displayed in red. To view the specific error, click on the
beam and the program will provide more information.

Edit. In the case of a sloped concrete beam, the Results
single sloped beam window can be accessed.
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Fig. 6.17

In the case of concrete beams, the window contains the
following options:

Geometry. Allows to modify the width and thickness of the
beam.

Reinforcement. Allows to edit the stirrups, the top, bot-
tom and skin reinforcements.

Code check, design, detailing and 3D view options
available.

In the case of sloped steel beams, the same dialogue ap-
pears as with the option Beams > Beam errors > Check
series for horizontal steel beams.

Fig. 6.18

Design concrete beams. Redesigns the reinforcement of
all the sloped concrete beams of the job using the forces
obtained from the last analysis.

Design steel beams. Redesigns the sections of all the
sloped steel beams of the job using the forces obtained
from the last analysis. Here, two options appear: Using
sections of the series greater than the current section and
using all the sections of the series.

6.2.4. Copy reinforcement between frames at diffe-
rent floors

It is possible to copy the reinforcement of one frame to ano-
ther similar frame regardless of its floor level. This can be
done using the option Copy reinforcement between fra-
mes located in the Beams/Wallsmenu in the Results tab.
The explanation on how to use this option is displayed
upon pressing F1.

• Copy reinforcement between frames of the same group
of floors.

Situate the main view at the floor at which the frames
are to be copied and select the frame to copy followed
by the frame or frames to which the selected reinforce-
ment is to be assigned.

• Copy reinforcement between frames on different
groups.

Situate the main view at the floor on which the frame to
be copied is located. Click on the right mouse button
and choose from the window that appears, the floor to
which the selected frame is to be copied. Upon doing
so, the selected floor will appear where the frames can
have the reinforcement assigned to them. Immediately
afterwards, the screen will return to the initial view; the
floor where the ‘master’ frame was selected.

Be it frames of the same group or frames on different floor
groups, the reinforcement is copied in the following way: in
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the case of assembly reinforcement and the first layer of
bottom reinforcement, the diameter, number of bars and
anchorage length. For the remaining longitudinal bars, the
diameter, number and length of the bars are copied. In the
case of stirrups, their diameter, separation and reinforce-
ment length are copied. Having copied the frame, it is re-
commended the reinforcement be checked in case the
reinforcement laid out has been reduced with respect to
what was required, as the program does not warn of this
when it is copied.

The frame onto which the reinforcement is to be assigned,
must comply with the following conditions:

• All spans must be of reinforced concrete.

• All spans must be of the same type. For example, it is
not possible to copy the reinforcement of a flat beam to
a lattice beam, however it is possible to copy the rein-
forcement from a flat beam to a dropped beam.

• The beams must contain the same number of spans.

• Any difference in span length must be less than 25 cm.

• If there are any elevation changes, their elevations and
positions must coincide.

If for one of the previous reasons, it is not possible to copy
the reinforcement of a frame onto another, the program dis-
plays information explaining the cause of the failure.

On the other hand, copying of reinforcement between
frames does not imply that the beam drawings will all be
the same; this will only be the case for those whose geo-
metry is exactly the same.

6.2.5. Design of steel beams

Once the structure has been completely analysed, the op-
tion is available to design the floor steel beams.

Additionally, once the job has been analysed and the analy-
sis results have been saved, the option Check series is
displayed in the Beam errors menu. The design can be
carried out at any moment, for example if the design option
was not selected at the time of analysing the structure or if
the beam section has been modified and the user wishes
to carry out a check without having to reanalyse the whole
structure.

6.2.6. Frame grouping

Within the Beams/Walls menu in the Results tab, the op-
tion Group frames can be found, which allows for frames
to be grouped amongst themselves. This is done after the
job has been analysed. If the grouping is not possible, the
program will warn of this and provide a reason.

This option does not undertake any checks regarding the
conditions of the grouped frames.

Any modifications carried out on one frame will affect all the
others in the group.

In the beam drawings, a single frame will appear per group,
indicating all the references belonging to the grouped
frames. The option, Ungroup frames, performs the oppo-
site process.

Finally, the option Add frame to grouping allows for new
frames to be added to a previously established group.

6.2.7. Block frame reinforcement

The option Block frame reinforcement allows for the
structure to be analysed maintaining the reinforcement of
those frames that are selected before the analysis. This tool
can be found in the Beam/Walls menu in the Results tab.
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6.2.7.1. Things to consider when using this option

The option Block frame reinforcement has been brought
about so not to loose the manual modifications of the
frames due to the job being reanalysed or due to minor
changes. This option does not intend to verify the frame
reinforcement.

If, once the reinforcement of the frames has been modified
manually, it is necessary to carry out small changes on the
structure and therefore re-launch an analysis, any manual
modifications made to blocked frames will not be lost.

The option Block frame reinforcement can be used to
maintain the reinforcement of those frames whose groups
have not undergone any changes or whose modifications
are insignificant.

Those frames that are not blocked will be undergo the rein-
forcement design process each time the job is reanalysed.

If the changes in the job imply a change in the number of
spans of a frame, it will automatically be unblocked.

Warning

Be aware that after a new job analysis, the program will
only check if the reinforcement provided (blocked reinfor-
cement) in the blocked frames possesses the required
steel area and if the deflection conditions are verified. The
remaining checks are carried out in the regular design pro-
cess (as in the case of unblocked frames). After a new ana-
lysis, any blocked frames not verifying the aforementioned
conditions will be displayed in the colour configured for
beam errors. The user should consult the reinforcement
containing errors (Results tab, Beams/Walls > Edit be-
ams) and decide whether, to resolve the problem, a small
modification to the reinforcement is sufficient or if the frame
should be unblocked and the reinforcement redesigned.

If significant errors appear in a blocked frame after a new
analysis, it implies that the changes undertaken in the job
after the blocking of the frame reinforcement substantially
affect it and therefore it is recommended it be unblocked
and reanalysed. When the program is reinforcing an un-
blocked frame, the program carries out all the checks sta-
ted in the selected code (bar spacing, anchorage length,
etc) using the forces obtained in the last analysis.

The program offers two options to redesign the blocked
frames: Redesign all the frames or Redesign frames with
changes (available in the Beam Definition tab, Analyse
menu). This last option proves to be a useful tool as the
program only redesigns the reinforcement of those frames
that have been unblocked and those whose section has
been modified.

All these considerations should be taken into account by
the user to decide which is the best solution.

6.2.7.2. How the option works

Having selected the Block frame reinforcement option,
the Frame selection window will appear.

Fig. 6.19

Here, all the frames of a group of floors can be blocked by
selecting the box situated in the All column and in the row
of the corresponding group. In the same way, by selecting
the box in the None column, it is equally possible to un-
block all the frames in a group of floors. If only a few frames
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in the group are to be selected, click on the Selection but-
ton in the row of the desired group. The selected group will
appear on screen where the frames to be blocked can be
selected by clicking on them with the left mouse button.
The outline of the selected frames will be drawn in red so to
be able to view those selected and those that are un-
blocked. To undo a selection, re-select the frame. By
clicking on the right mouse button the Frame selection
window will reappear where the chosen frames will be dis-
played in the Selected column in the row of the chosen
floor group.

Fig. 6.20

6.2.8. Steel beams

6.2.8.1. Shear stud errors

If a condition is not verified, it can be consulted using the
option Beams > Beam errors.

Errors that can arise when using shear studs include the
following:

• The nominal diameter of the shear stud is too small. Its
diameter must be increased.

• The total length of the shear stud is insufficient. In-
crease the length of the bar or head thickness.

• The shear stud is not anchored in the slab. Reduce the
length of the bar or the thickness of the head.

• The total length of the shear stud is insufficient for its
nominal diameter. Increase the length of the bar.

• The head diameter is insufficient for its nominal diame-
ter. Increase the head diameter.

• The head thickness is insufficient for its nominal diame-
ter. Increase the head thickness.

• The nominal diameter of the shear stud does not as-
sure the ductility of the connection. Increase the diame-
ter of the bar.

• The length of the shear stud is insufficient to assure the
ductility of the connection. Increase the length of the
bar.

• The number of shear studs is excessive for the length of
the beam. Increase the diameter of the bar or provide a
greater section in order to reduce the shear force.

• The thickness of the flange is insufficient to place the
shear stud. The thickness of the flange onto which the
shear stud is welded must have a minimum value. This
thickness depends on the diameter of the shear stud.

• The width of the flange is insufficient for two shear studs
to be placed. Bear in mind that there are minimum dis-
tances to maintain between the faces of the studs and
between the stud and the edge of the flange. A section
with a greater flange width must be chosen.

6.2.9. Corbel checks

Once the structure has been analysed, it is possible to
carry out a check on the corbels introduced in the job by
clicking on Beams/Walls > Corbels > Check corbels
from the Results tab. Any corbels displaying design errors
will be drawn in red. A report of the checks performed on a
corbel (regardless of whether designed correctly or not)
can be obtained by clicking on it.
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6.2.9.1. Redesign corbel reinforcement

Redesigns the reinforcement of all the corbels introduced
in the job using the forces obtained from the last analysis.

6.2.10. Sloped beam reinforcement edition

It is possible to modify sloped beam reinforcement. By se-
lecting Edit from the Sloped beam window from the Re-
sults tab. The reinforcement can be edited and modified
upon selecting the Reinforcement button.

Fig. 6.21

6.2.11. Configuration of the beam reinforcement
editor

In the Results tab, upon selecting Beams/Walls > Edit
beams > Configuration of the beam reinforcement
editor, a window will appear containing the following op-
tions:

Fig. 6.22

• Reinforcement views. The types of reinforcement to
view on screen can be chosen so to modify or consult
the reinforcement more comfortably. It is possible to
consult:

- Top reinforcement
- Bottom reinforcement

- Skin reinforcement
- Stirrup intervals
- Beam section
- Confinement zones

Fig. 6.23

• Splice lengths (lb). This can be modified by multiplying
it by a chosen factor.

Fig. 6.24

6.2.12. Force diagrams

Within the Envelopes menu in the Results tab, the option
Forces in beams can be found. These options allow to
consult the force envelopes (Moments, Shears and Tor-
sion), for simple or combined load cases.

Fig. 6.25 Fig. 6.26 Fig. 6.27
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If the option Loadcase or Combination is activated, a
scrolling menu appears in which one may select the des-
ired loadcase or combination. If a dynamic earthquake
loadcase is selected, another scrolling menu will appear in
which the Vibration mode of the structure can be selec-
ted.

Having accepted the dialogue box, by clicking on the
beam alignments, hollow core slabs or composite slabs
with the left mouse button, their force diagrams may be
consulted.

6.3. Drawings and reports

6.3.1. Sloped beams

A drawing can be obtained of the sloped beam reinforce-
ment.

6.3.2. Corbels

Corbel drawings display the dimensioned geometry of the
front and side views of the element, the main reinforcement
and stirrups, the measurements and references of the
frame and the column on which it is situated.
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7.1. Floor slab introduction

7.1.1. Floor slab floating menu

To open this menu, click on Slabs > Panel manager in
the Beam Definition tab. This menu contains the following
options:

Fig. 7.1

• Define panel. Upon clicking on this option, the Panel
manager dialogue box will appear, in which the availa-
ble slab types are displayed: Joist floor slabs, Hollow
core slabs, Composite slabs, Waffle slabs, Flat
slabs, Mat foundations and Awaiting definition.

Fig. 7.2

When a structural perimeter (area surrounded by
beams) has been created, the program automatically
defines it as a panel ‘Awaiting definition’. It is displayed
on screen with a question mark, to remind the user that
it must be defined.

Fig. 7.3

When introducing the panel, the direction of the reinfor-
cement, ribs or joists must be indicated. Once this has
been accepted, place the mouse cursor over a space
closed off by beams so to select it and then click on an
element parallel or perpendicular (depending on the se-
lected introduction configuration) to finish off the intro-
duction and establish its layout.

• Delete panel (introduce opening). Place the cursor
on the selected slab. Once this has been clicked on,
the program will delete it.

• Change insertion point.

• Change layout. Upon choosing this option, a dialogue
appears allowing to select the way in which the slab is
to be modified. Once selected, upon placing the cursor
on the slab, it will be highlighted and if it is clicked on
using the left mouse button, it will be selected. The pro-
gram will then prompt the user to select the beam or the
two pass-through points that will define is new direc-
tion.

7. Floor slabs
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• Panel data. Displays the data of the panel and allows
for it to be edited.

• Copy panel. Copies the data of a previously selected
slab by clicking on it. The window that appears de-
pends on the type of slab. It is possible to select what
data is to be copied (Plane, Fixity coefficient, etc). At-
tention: It is very important to deactivate the Plane op-
tion whilst copying slabs with different slopes. If the pa-
nel from which the data is to be copied is located on
another floor, by clicking on the right mouse button, a
floor group selection window will appear.

Select the group in which the panel is located and click
so to display the group. Select the panel and the pro-
gram will automatically return to the group where the
panel is to be copied to.

• Detail forms. Activating this option when waffle slabs
have been introduced will display the forms making up
the lightweight elements between the ribs; at the same
time, the ribs are drawn with their real width.

• Minimum moments. This option is only available if the
following types of floor panels have been introduced in
the group: joist floor, hollow core or composite.

Upon selecting this option, a dialogue will appear allo-
wing for the minimum moment values to be assigned to
the different slabs.

• Environment. This option is only available if prestres-
sed joist or hollow core slabs have been introduced in
the group.

Upon selecting this option, a dialogue box will appear
in which the environment may be selected. Using the
buttons Assign or Assign all, it is possible to assign it
individually or to all the panels of the group.

• Fixity coefficient. A dialogue appears allowing to se-
lect the edge fixity coefficient. Using the buttons Assign
or Assign all, it is possible to assign the selected coeffi-
cient to each individual panel or to all the panels of the

same group. This option is not available for waffle
slabs. If an edge fixity coefficient less than one is to be
assigned to this type of panel, it must be done using
the End fixity option from the Beam/Walls.

• Construction process. This option is only available for
hollow core slabs. Allows to specify if the construction
process of the hollow core slab is to be carried out with
Shored construction or Unshored construction.

• Enter double joist. This option is only available for joist
floor slabs. Creates a second or triple joist next to a se-
lected joist in the panel.

• Delete double joist. In the case where there are dou-
ble or triple joists in a panel, it is possible to delete
these by clicking on them, having selected this option.

7.1.2. Floor slab types

7.1.2.1. Awaiting definition

When a structural perimeter is defined by means of beams
or walls, the program automatically assigns a panel awai-
ting definition to the inside of this perimeter. Using the op-
tion Awaiting definition from the Panel manager dia-
logue box (Slabs > Panel manager > Define panel) any
opening or previously defined panel can be changed to
one awaiting definition. Panels awaiting definition can be
substituted by openings (Slabs > Panel manager > Delete
panel) or by any other type of panel available in CYPECAD
(Slabs > Panel manager > Define panel). A panel awaiting
definition can be assigned an elevation change, a slope
and a depth. If the depth is assigned, any flat beams
around its perimeter will adopt this depth.
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Fig. 7.4

Jobs containing panels awaiting definition cannot be analy-
sed and so there is less probability of the user forgetting to
define a panel before the analysis.

The panel awaiting definition is displayed in the 3D views.
This allows the user to have a 3D view in which openings
and slabs can be seen before the final type of panel has
been introduced.

7.1.2.2. Joist floor slabs

Depending on the selected code, various types of joist floor
slabs can be introduced.

Fig. 7.5

7.1.2.2.1. Reinforced / Prestressed concrete joist floor
slabs

The user can choose between using a predefined joist floor
slab from the Library (catalogue of manufacturers) or to
define a new floor slab by defining its geometrical pro-
perties. Depending on the selected code, the user may
only have the option of creating a new slab by defining its
geometrical properties, in which case the dialogue box will
not display the two options.

By geometrical properties

The user can create, copy, delete, etc., generic panel types,
for use when the panel that will finally be used in the job is
unknown, as well as being a practical aid as to establish
whether the joists to be used will be reinforced or prestres-
sed joists due to their deflection.

When creating or editing a concrete joist floor slab, the fol-
lowing data will have to be entered:

• Reference. Panel description.

• Compression layer thickness. Thickness of the com-
pression layer above the form.

• Form depth.

• Rib spacing. Distance between the axes of adjacent
joists.

• Rib width. The minimum thickness of the joist is to be
indicated here.

• Rib width increment. This increment refers exclusively
to the thickness of the intermediate walls of the forms
for the calculation of the stiffness and cracking moment
when calculating the deflection. This is only considered
when using concrete forms.

• Concrete volume. Depending on the data introduced
previously, the program calculates the volume of
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concrete per square metre. Nonetheless, the user can
modify this value by activating the box and introducing
the corresponding value.

• Type of form. The program allows to select between a
concrete, terra-cotta, polystyrene or generic form to be
used. Based on all the parameters introduced at this
stage, the program calculates the total weight of the
panel per square metre (volume of the concrete plus
the forms). When generic forms have been used, their
surface weight must be indicated by the user.

• Deflection Code check. Depending on whether the slab
built on site is composed of reinforced or prestressed
joists, the type of joist has to be indicated so the pro-
gram may calculate the deflection accordingly, as the
cracked stiffness in these cases varies greatly (the case
may occur where the cracked stiffness is practically
equal to the gross stiffness, due to the prestressed ef-
fect, and so, the cracked stiffness/gross stiffness ratio
should be consulted with the manufacturer).

Fig. 7.6

Once the geometrical properties of the slab have been de-
fined, the user can opt to export the defined slab to an in-
ternal library, so the slab may be used in future jobs wi-
thout the need of having to define the properties sheet
again.

Library

These are prefabricated joists whose data sheets or autho-
risations have been provided by various manufacturers.
CYPE does not assume any responsibility for the data pro-
vided and so, it is recommended these be verified before
use. Nonetheless, a logical control has been carried out on
the data introduced. On the other hand, in those cases
where the user wishes to introduce data belonging to ano-
ther manufacturer, it can be forwarded to us and we can in-
clude it in the program, or, alternatively, a new data sheet
can be created using the Panel data sheet editor program.

Fig. 7.7

The data to select is as follows:

• Reference (optional). To be introduced only when the
user wishes to assign a reference different to that pro-
posed by the program, which is the name of the sheet
plus the name of the panel, e.g.: FORMA, 25+5, Arlite.

• Sheet. Select the manufacturer. It may occur that the
same manufacture may possess various joists models
(different steel properties, rib spacing, etc.).

• Floor slab. Depending on the previously sheet selected,
a floor slab may be chosen amongst those available in
the series with varying thickness and rib spacing.
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Using the previously selected data, a floor slab is obtained
whereby the properties are summarised as information for
the user: joist concrete, job concrete, prestressed steel, etc.

Floor slab sheet: this option attaches the technical proper-
ties of the slab for single as well as double joists. The
contents of the properties sheet are those provided by the
manufacturers. It contains data that must be provided and
other that is recommended be introduced:

Reinforced joists

• Positive flexure of the slab. The data corresponds to
that at mid-span:

- Type of joist. Established name of the joist.

- Reinforcement per joist. This is the reinforcement
defined by the: Base reinforcement + additional
reinforcement of the whole length of the joist + ad-
ditional reinforcement of a smaller length.

- Rib area. Steel section area in cm2.

- Ultimate moment.

- Cracked moment. To calculate the deflection using
the Branson method.

- Total stiffness. This is used to compose the stiffness
matrix of the concrete joist.

- Cracked stiffness. To calculate the deflection using
the Branson method.

• Negative bending of the floor slab. The data refers to
the support or end of the joist:

- Additional top reinforcement per rib. The reinforce-
ment is defined by reinforcement 1 + reinforcement
2 of a smaller length. Both lengths are calculated by
the program.

- Rib area. Steel section in cm2.

- Typical section ultimate moment. Maximum resisted
moment (ultimate).

- Infill section ultimate moment. Maximum resisted
moment (ultimate) in the case where there is no
form (infill).

- Cracked moment, total stiffness and cracked stiff-
ness. Same as for positive flexure.

• Ultimate shear force of the section. Ultimate shear force
resisted by the section. There may be several values
depending on the type of truss, for example. For this
reason, the type of truss to use will be displayed on
screen and in the drawings.

Prestressed joists

• There are two differences between the prestressed joist
sheets and those belonging to reinforced joists:

1. Service moments are displayed. These are the re-
sisted moments depending on the type of prestres-
sed concrete and the exposure class. The equiva-
lence is as follows: Environment I = Exposure class
III (structures inside buildings or external structures
with little humidity exposure); Environment II = Ex-
posure class II (structures with normal, non-aggres-
sive exposure, or ordinary terrain); Environment III
= Exposure class I (structures exposed to aggres-
sive industrial or marine atmosphere, or in contact
with aggressive soil, salt water or slightly acid water
according to the outdated EH-91 and EP-93 codes).
The resulting design service moment is compared,
depending on the environment defined for the joist
(using the option Slabs > Panel manager > Envi-
ronment) to that of the sheet, and if it is smaller, it is
accepted. On the contrary, a joist is found verifying
all the conditions and if non are found, an error
message is emitted at the end of the analysis.

2. No shear reinforcement exists.
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7.1.2.2.2. In situ joist floor slab

This consists of beams completely built on site. These are
built analogically to concrete beams. Therefore, a base
reinforcement can be assigned to them using the option
Slabs > Base reinforcement. Upon creating or editing
an in situ floor slab, the following data must be indicated:

Fig. 7.8

• Reference. A description should be indicated here for
the type of slab.

• Form. Choose the type of form to use: concrete, terra-
cotta, etc. Possibility to create, copy, delete, etc. the dif-
ferent types of form. The forms are generated using the
library (for more information, consult the element Li-
brary manager).

• Compression layer thickness. Thickness of the com-
pression layer above the form.

• Rib spacing. Distance between joist axes.

7.1.2.2.3. Steel joist floor slab

This consists of rolled I-section joists. Upon creating or edi-
ting a slab composed of joists of this type, the following
data should be defined:

Fig. 7.9

• Reference (optional). To be introduced only when a dif-
ferent reference to that proposed by the program is to
be displayed, which is that of the section series + the
rib spacing.

• Rib spacing. The type of form is to be chosen:
concrete, terra-cotta, etc. as well as its properties (di-
mensions, weight, etc.). All form types can be created,
copied, deleted, etc. The forms are generated using the
library.

• Compression layer thickness. Thickness of the com-
pression layer above the form.

• Rib spacing. Distance between joist axes.

• Section series. The series of the section is selected but
not the exact section within the series. The advantage
here is that the program automatically calculates the re-
quired beam following the resistance criteria each time
the joists are simply supported between the supports
(the program automatically provides the slab a fixity
coefficient of 0, which cannot be modified).

7.1.2.2.4. Open web joist floor slab

This consists of simply supported steel truss joists. Upon
creating or editing a slab using this type of joist, the follo-
wing data should be entered:

CYPE

CYPECAD68



Fig. 7.10

• Reference (optional). To be introduced only when a dif-
ferent reference to that proposed by the program is to
be displayed, which is that of the number of sections of
the two chords, the section series and the rib spacing.

• Open web joist type. Select the type of joist. Each of the
chords shall be composed of one or two identical sec-
tions depending on the selected type. The diagonals of
the truss will be a single section, belonging to the series
selected subsequently.

• Section series. The selected section series should be
composed of rolled or laminated steel sections. In a si-
milar way as with steel joists, the series of the section is
selected but not the exact section.

• Nominal depth of the truss. Distance from the top sur-
face of the chord to the bottom surface of the chord
(not the distance between chord axes).

• Passage of the truss. The angles of the truss should be
between 30º and 60º.

• Rib spacing. Distance between the joist axes.

• Slab thickness. Thickness of the concrete layer (non-
contributing) above the top chord.

Option Job > General options > Torsional stiffness re-
duction coefficients of a joist floor slab.

Fig. 7.11

It is possible to modify or consult the value of a torsional
stiffness reduction coefficient of a joist floor slab.

7.1.2.3. Waffle slabs

Slabs > Panel manager > Define panel > Waffle
slabs. Waffle slabs can be divided into two types: those
with a lost form or those with a removable form. When defi-
ning a new waffle slab, previously defined forms can be im-
ported from the library (will open automatically upon ente-
ring the option for the first time) or alternatively, defined by
the user.

Fig. 7.12
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Once a form type has been selected, this can be edited in
case the data provided needs modifying to adapt it to the
needs of the user. Additionally, the layout of the forms may
be viewed on screen by selecting the icon from the Pa-
nel manager menu.

Fig. 7.13

Fig. 7.14

When entering the panel, the user may choose to enter it
parallel to a beam or by means of two pass through points
(in case the are no beams in close proximity with the
sought layout).

Waffle slab panels defined in one group may be copied to
other panels in the same group. Similarly, once a base rein-
forcement has been defined, it may be assigned to the
waffle slabs of the group.

7.1.2.3.1. Drop panels

The configuration options for drop panels can be located in
Slabs > Drop panels. A dialogue box appears displaying
the options (the amount of options available depending on
whether or not drop panels have been introduced or not).
By clicking on the Configuration of drop panel genera-
tion button, the following parameters can be defined:

Fig. 7.15

Angle of vision. From the centre, for each column face,
the program sends a vision cone in the directions of the
grid. Each grid is established with the angle provided in this
option. If another column falls within the angle of vision, the
distance to this column will be taken as the design span
length used in the generation of the drop panel. If there are
various columns within the angle of vision, the program will
take the nearest one. If there are no columns in sight, the
minimum length will be assigned.

Infill length. The infill is measured from the column face to
the drop panel perimeter edge, and such length is calcula-
ted as a percentage of the distance between the column
considered and the nearest column within the angle of vi-
sion.

Minimum length. Minimum length from the column face to
drop panel perimeter edge with respect to the drop panel
depth, in case of there not being any other columns within
the angle of vision.

Maximum length. Maximum length from column face to
drop panel perimeter edge with respect to the drop panel
depth.
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7.1.2.4. Hollow core slabs

Hollow core slabs may be imported from CYPE’s library or
created by the user. Upon creating a new slab the program
will require an amount of data to be introduced. To aid the
user in its introduction, a book icon can be located in the
top right hand corner of the dialogue box, providing infor-
mation on what is to be defined.

Fig. 7.16

7.1.2.5. Composite slabs

Fig. 7.17

Composite slabs consist in a steel deck profile collabora-
ting with the concrete slab and with top and bottom reinfor-
cement. The steel deck profile can be used to work in one
of the following ways:

• Form deck. During the construction phase, the deck
alone resists its dead load, the weight of the fresh
concrete and the construction live loads. During the ser-
vice phase, it is only the reinforced concrete slab that
has a resisting function.

Some manufacturers propose various ways to position
the deck: ‘n’ or ‘u’, depending on the properties sought
by the user. ‘n’ represents the normal position whilst ‘u’
the inverse position. Once the composite slab has been
introduced on screen, a discontinuous line will be
drawn at the deck panel overlap axis, where the width is
that indicated on the data sheet.

• Composite deck. During the construction phase the
deck works as lost formwork. During the service phase,
the deck is considered to combine structurally with the
hardened concrete, acting as reinforcement in tension,
resisting the positive moments in the finished floor slab.
The deck is capable of transmitting shear stresses at its
interface with the concrete as long as a mechanical
connection is provided by deformations in the deck
(embossments).

The analysis and design of the steel deck are carried out
according to the code: UNE ENV 1994-1-1: June 1995-Eu-
rocode 4: Composite steel and concrete construction des-
ign. Part 1-1: General – common rules and rules for buil-
dings, which is the official version of the UNE ENV 1994-1-1
dated October 1992.

Composite slabs are applicable in structural projects in
which the applied loads are predominately static loads, in-
cluding industrial buildings where the slabs can be submit-
ted to mobile loads.
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The total thickness of a composite slab, the thickness of
the concrete on the ribs of the deck and the minimum
height of the shear studs on the deck (in the case of com-
posite beams) are limited.

7.1.3. Sloped slabs

Defining and assigning sloped and different horizontal
slabs on the same floor.

Firstly, all the elements of the floor should be introduced
with the same horizontal elevation. Having done this, the
various slopes or horizontal elevation changes can be assi-
gned to them.

This option is located in Groups > Sloped floor slabs/
El. Changes in the Beam Definition tab.

7.1.3.1. Sloped floor slabs/ El. Changes Window

The following fields can be found in the dialogue box:

• Name. Reference given to the defined plane. This field
can be edited. If a yellow arrow appears to the left of
the name, it represents that the plane in question has
been assigned to a floor.

• Colour. Displays the colour assigned to each plane to
recognise where they have been assigned on the floor.

• Data. Field in which the value of the elevation plane is
to be entered, in the case of horizontal planes, or where
the elevation values can be modified.

• Assign. Assigns the defined plane to panels defined in
the floor group. All those to which the plane is assigned
will adopt the colour of the new plane.

7.1.3.2. Creation

An inclined plane can be defined in three different ways: 3
points with el. change, horizontal line with slope, and maxi-
mum slope.

Fig. 7.18

For each one, the definition can be done analytically (Edit)
or graphically on the floor (Define on floor). Once the
pane has been defined, it should be assigned to a pre-
viously defined slab. Using the Define on floor option, the
window will close and the floor to which the plane is to be
assigned will appear. The plane is then defined by graphi-
cally introducing the elevations relative to that of the floor at
the specified locations. Having a DXF template of the floor
on screen can prove to be a practical tool as it can aid in
snapping to beam axes, corners, beam edges, etc. to des-
ignate the point locations on the floor. In all cases, if beams
have been introduced, the mouse cursor will be displayed
as a red point when over a beam’s axis or edge, otherwise
it will be displayed in black.

Using the Edit option, the required data will have to be in-
troduced manually and the position of the points will be pla-
ced automatically. The program will position the elevation
changes graphically on the floor in the same way as with
the Define on floor option.
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• 3 points with el. change. Select three points on the floor
and introduce the relative elevation (el. change) of each
with respect to the floor.

• Horizontal line with slope. Select two points on the floor
(the direction of the maximum slope will be perpendicu-
lar to the line joining the two points), and introduce a
single elevation for the two points as well as the slope.

• Maximum slope. Two points indicating the maximum
slope. Introduce the elevation change of the first point
relative to that of the current floor and the slope.

7.1.3.3. Edit

Upon clicking on this option, the window closes and the
definition points appear on screen displaying the elevation
data. Another window also appears, displaying the introdu-
ced data analytically.

• Edit plane on floor. If the cursor is placed on a definition
point, it will be highlighted in yellow, indicating it can be
displaced. If it is placed on an elevation or slope text,
the value can be modified and the new value typed in.
Once this has been done, click on accept.

• Edit a slope analytically. The values can be modified in
the window. Having done so, click on accept.

7.1.3.4. Assign

Once the slope has been defined, it can be assigned to
previously introduced panels. After assigning a slope, a
blue arrow will appear on the panel indicating the direction
of the maximum slope in the downwards sense. The direc-
tion of the ribs of a panel should always be parallel or per-
pendicular to the maximum plane. If a plane is not defined
in this way, when it is assigned, the program will emit a war-
ning.

7.1.3.5. Automatically assign a slope to beams

If a slope has been assigned to a beam and a panel exists
with another beam with a different slope, the program de-
tects this incongruence and displays the affected beams in
red. It is possible to then assign the slope of the adjacent
panel to the beams by simply clicking on them.

7.1.3.6. Advice on sloped panels

Preliminary concepts
To introduce a sloped slab, its horizontal projection should
first be drawn. This can be done on a higher group (to-
wards the top) or lower group (towards the bottom).

The user should have a clear image of the appearance of
the building to provide a precise definition of the floor
groups.

Below are some examples which should be taken into ac-
count when defining sloped planes.

Current cases
Case 1. There are no horizontal panels supported by the
beams defining the sloped panel. In this case, a group is
defined with the elevation of the small columns of the roof
and positive elevation changes are assigned to the inclined
planes.

Fig. 7.19
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Case 2. There is a horizontal panel at one of the ends of
the inclined plane. In this case, the inclined plane cannot
be defined in the lower group and then assign positive ele-
vation changes as it would overlap the horizontal panel.

Fig. 7.20

Here, the horizontal panel has to be defined in the lower
group and then on the higher group, another horizontal
slab onto which the elevation changes will be assigned. All
the elevation changes in this higher floor will be negative.
The edge beams of the two groups are shared between
the two groups (common beam); the beam need only be
entered once, for the lower group, for example. Before mo-
ving up to the higher floor, edit the beams and make them
common with the higher group and they will automatically
appear in that group.

Fig. 7.21

For more information, consult the option Beams/Walls >
Common beam > Create common beam.

Case 3. Horizontal planes at either end of an inclined plane.
This can be the case of a ramp where common beams have
been used at its ends. An intermediate group between the
two horizontal groups should be defined to allow for the pre-
liminary horizontal introduction of the ramp. Once introdu-
ced, the defined slope can be assigned to the ramp.

Fig. 7.22

Case 4. There are beams that when projected vertically
cause overlaps to occur. If projected vertically downwards
on the floor group where the smallest roof column ends, a
beam or panel overlap arises. In this case, a floor group
must be defined at the elevation of each beam or panel
producing this overlap.

Fig. 7.23

Creation and introduction process of a sloped
slab

It is important not to proceed to the next stage without ha-
ving first completed the previous step. The following is a
summary of the process:
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• Define the group of floors, depending on which of the
previously described cases best describes what is to
be introduced. It is very important to draw the building
beforehand with all its elevations.

• Introduce all the horizontal panels, except those that will
eventually be assigned a slope.

• Assign any common beams, if any.

• Introduce all the panels that will be assigned a slope. It
is advisable to use a DXF or DWG template or any
other template displaying the intersection lines of the
various sloped planes. Separation or transition beams
of these planes shall be entered with their axes adjus-
ted at the intersection line of the template.

• Create all the sloped panels.

• Assign the slope plane to the panels.

Other aspects to take into account

• Horizontal beam projection. When a sloped plane is
assigned to a beam, the program vertically projects the
axis or the edge of the beam, depending on whether
the previous adjustment is to the axes or edge of the
beam. Once this projection has been carried out, the
width of the projected beam is drawn in such a way that
the top face of the beam is seen with a continuous line.
Therefore, a ridge beam, will always appear to have a
greater width whereas a valley beam will be narrower.

• Beam rotation. If the user wishes for those beams with
a horizontal longitudinal axis, such as ridge beams, roof
edge beams etc., to rotate their transverse section so
to have the same angle as the adjacent panel, the
beams must be defined as flat beams. If they are defi-
ned as dropped beams, they will not rotate.

It may occur that the encounter between two sloped
planes may not coincide with the ridge or valley beam.
In this case, the beam will not rotate, even though it has

been defined as a flat beam, and, additionally will have
enough depth to support both panels.

• Limitations. Several limitations exist regarding the
used of sloped planes with walls:

- A sloped panel cannot be supported by a wall.
- A common beam cannot be created with the crown

of a wall.

• Drawings. Drawings can be obtained by clicking on:
File > Print > Job drawings > Floor plans. The va-
lue of the slope is drawn next to the elevation change
text at a point of the sloped plane. It is also possible to
draw a sketch of the floor. In the Others tab within the
Configure button, the Floor layout option is available
(only if there are sloped panels) where the size of the
sketch box can be indicated in which the columns,
beam axes and slope arrows are drawn.

Examples

• Example 1

In the case of a roof with two slopes (mansard roof). An
overlap occurs if one of the edges of the roof is projec-
ted downwards towards the horizontal plane below it.

This example can seen in Case 1, explained previously.
Therefore, the slopes will have to be defined in the roof
group. The groups are defined as follows:

Fig. 7.24
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Fig. 7.25

The beams which have been designated as common
beams can be seen in the group below the roof group. This
has been done using the option Beams/Walls > Com-
mon beam > Create common beam whereby the beam
has been selected to be common with the roof group. The
figure displays these beams with a dash-dot axis.

The common beams appear automatically in the roof
group and so it is not necessary to redefine the beams.
The sloped roof, even though it contains various slopes,
can be defined in a single floor group. Once this has been
done, the remaining roof beams and panels can be intro-
duced. Since the sloping panels have been defined in the
roof group, all the sloped panel elevations will be negative.

Observe layouts 1 and 2.

Fig. 7.26

Fig. 7.27

Fig. 7.28

Layouts 3 and 4 are symmetrical to 1 and 2.

• Example 2

This mansard roof contains two dormer windows, but
these are only taken into account to simplify the analy-
sis. The sloped roof is laterally supported by dropped
beams parallel to the façade.

Fig. 7.29
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A cantilever roof is not defined as a cantilever as such,
but is built on the horizontal floor below. The groups are
defined as follows:

Fig. 7.30

The common beams are then assigned to the horizon-
tal and sloped panels. This is done using the Common
beam option where the roof is selected as the common
group. The axes of the beams are displayed with a
dash-dot line.

The common beams appear automatically in the roof
group, and so these beams do not have to be redefined.
The remaining roof beams and panels are inserted and
the line loads representing the loads of the mansard roof
and beams making up the attic are introduced.

Fig. 7.31

Since the sloping panels have been defined in the roof
group, all the sloped panel elevations will be negative.
Check to view the layout of the first panel. The second
panel is symmetrical.

Fig. 7.32

Fig. 7.33

• Example 3

A ramp descending to a garage basement is to be in-
troduced.
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Fig. 7.34

An intermediate group of floors between the founda-
tions and the first slab is created to build the ramp, for
example, halfway between both groups.

In the Column definition tab, several independent co-
lumns are introduced to sustain the ramp. These co-
lumns are to span between groups 0 and 1 (that of the
ramp).

The ramp is introduced in group 1. This is defined using
a flat slab and flat beams spanning between columns.
A masonry wall is introduced at the bottom end of the
ramp. The top end will be defined as a common beam
with the perimeter beam of the opening in group two.
Three panels are defined; two sloping and one horizon-
tal for the curve.

Fig. 7.35

Fig. 7.36

Group 2 contains the ramp opening in the slab and the
common beam with group 1.

Fig. 7.37

Remember:

- A sloped panel cannot be adjacent to a wall

- A common beam cannot be created using the crown beam of
a wall

- It is preferable that curves be defined on a horizontal plane
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• Example 4

Introduction of an access ramp between car park
floors.

An intermediate floor group is introduced for each ramp
between floors. This is defined with a flat slab and flat
beams spanning between columns. At the bottom end
of the ramp, a common beam is created with the beam
directly underneath it in the floor below. At the top end
of the ramp, a common beam will be created with the
beam above it.

Five floors are defined, three sloping and two horizontal
for the curves.

Fig. 7.38

Fig. 7.39

The top group will contain the opening of the ramp as well
as the common beam with the group below.

Fig. 7.40

7.1.4. Introduce openings

Within the Slabs menu, the Introduce opening option is
located, containing the options detailed below. For each of
the options, the Current beam dialogue box will open so
the user may select the type of beam to be introduced.

Fig. 7.41

• Introduce rectangular opening parallel to beam. A
beam parallel to one of the edges of the opening is to
be selected. To define the opening, select the points
where the two opposite internal corners will be located.

• Introduce rectangular opening with 0 angle. The
opening that will be introduced will have an angle of 0º.
To define it, select the points where the two opposite in-
ternal corners will be located.

Remember:

It is preferable that curves be defined on a horizontal plane.
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• Introduce rectangular opening matching the panel
angle. The two opposite internal corners of the ope-
ning are to be selected, bearing in mind that the angle
of the opening will be that of the ribs of the slab in
which it is located. If the panel where it is introduced is
empty, the new opening will be generated with its sides
parallel to the general axes.

• Introduce rectangular opening with any angle. In
this case, the user must select two points defining one
of the internal edges of the opening and then drag the
cursor to the point of the opposite internal edge.

7.1.5. Floor slab options

Slab options can be located within the menu: Job > Floor
slab options in the Beam Definition and Results tab.

Fig. 7.42

• Active deflection of joist slabs. The default values are
different, this option is similar to that of concrete
beams.

• Total long term deflection of joist slabs. This option is
analogous to that of concrete beams.

• Shear in floor slabs of in-situ joists. This option only ap-
pears if the concrete analysis is to be done according
to the Spanish EHE code. The program will verify whe-
ther it is necessary or not to provide shear reinforce-
ment in accordance with the code. If it is necessary, if

this option is activated, the EF formula is applied which
does not depend on the area of longitudinal steel in ten-
sion and considers that the shear resistance is a func-
tion of the concrete strength used. Therefore, this alter-
native is applicable based on what is stated in article 1
of EHE.

• Design of open web joists. Here, three options appear
providing design alternatives:

- Design all sections equal
- Design chords equal
- Design sections individually

7.2. Slab analysis and results

7.2.1. Joist floor slabs

7.2.1.1. Views of joist floor slabs

These options are located in the menu: Joists > Views in
the Results tab.

Fig. 7.43

• Show Moments/ Types

This option works in combination with Show forces for
all types of joists. If this last option is activated, the
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bending moments (with the applied safety factor and
per metre length) are visible. On the contrary, the follo-
wing can be seen:

The type of joist in the case of prestressed and reinfor-
ced joists.

The section in the case of steel joists and open web
joists.

The diameter and length of the bottom reinforcement in
the case of in-situ joists.

• Show Shears

This option works in combination with Show forces for
all types of joists. If this last option is activated, the
shear forces (with the applied safety factor and per me-
tre length) are visible. On the contrary the following can
be seen:

The type of truss in the case of prefabricated reinforced
joists.

The diameter and separation of the shear reinforcement
in the case of in-situ joists.

• Bottom reinforcement bars of in-situ slabs

Allows to view the bottom reinforcement of in-situ slabs.
This option is not available if the option Show forces
for all types of joists is activated.

• Show forces for all types of joists

If this option is activated, the positive bending moments
and shears appear next to each joist (as long as the
Show Moments/Types and Show Shears options are
activated).

• Show grouped

If this option is activated, the forces/types of joists for
each group of identical joists are displayed.

• Top reinforcement

- Show bar bending detail. Only for sloped slabs. A
bar bending detail is drawn next to the bar.

- Show bar bending mark. The point at which the bar
is to be bent is indicated by a small line perpendicu-
lar to the axis of the bar.

7.2.1.2. Match

This option can be found in the Joists menu in the Results
tab.

The joists are grouped in such a way that the following sta-
tement is confirmed:

(Maximum moment of the group – Minimum moment
of the group) < (%) x Maximum moment of the group

Where (%) is the percentage indicated by the user.

Once the joists that make up each group are known, the
program carries out the matching of the different combina-
tions of each one. The matching of the combinations is car-
ried out at each of the points at which the joist has been
discretised, according to what has been defined by the
user and the type of force:

• Bending Moments:

- If the user has selected matching the bending moments
to the maximum moment, the program will take the
maximum value for each point from all the combina-
tions of each of the joists that make up the group.

- If the user has selected matching the bending moments
to the average moment, the program will take the ave-
rage value for each point from all the combinations of
each of the joists that make up the group.
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• Shear:

The program will take the maximum shear value
amongst all the combinations for each joist making up
the group.

To match the top reinforcement, a fixed percentage diffe-
rence and a matching criteria (maximum or average) have
to be defined by the user. Once the parameters in the dia-
logue box have been defined and accepted, the program
compares the steel percentages of the top reinforcement of
the first joist with that of the adjacent joist. If the percentage
difference is less than that selected, both are matched to
the greater area of the two (in the case when this option is
selected), or the average of the two (in the other case). The
steel area obtained in this first step is then compared to
that of the next adjacent joist, and the process is repeated.
This is done until all the joists of the panel have been analy-
sed and for each individual panel of the job to obtain a
more even reinforcement distribution.

7.2.1.3. Errors

Joists containing deflection, shear or any other design error
are displayed in red. To know the exact error, click on
Joists > Errors then on the joist in question and the pro-
gram will indicate the error that has been encountered.

Possible joist errors include the following:

• Bottom reinforcement:

- Deflection limits. When the instantaneous, long term
or active deflection limit has been surpassed (due to
dead loading, live loading or assembly load). It is re-
commended the thickness of the slab be increased.

- Positive moment at joist support. Change the fixity
coefficient of the panel or study the continuity of the
bottom reinforcement.

- Insufficient floor slab depth to resist flexure. It is re-
commended the thickness of the panel be increa-
sed.

- No joist has been found to cover the maximum po-
sitive moment in the case of prestressed or reinfor-
ced joists. It is recommended the thickness of the
panel be increased.

- The width of the rib does not allow for the reinforce-
ment due to compatibility problems with the bar
spacing and cover. For in situ joists, the bottom rein-
forcement does not fit in the rib width. Solution: in-
crease the slab depth or increase the thickness of
the rib.

- There are no sections in the series that do not fail for
this floor slab and form geometry. This occurs in
steel joists probably due to having introduced an
excessive rib spacing with respect to the width of
the form, in such a way that it is not possible to sup-
port it on the flanges of the section. An appropriate
rib spacing for the form must be placed or vice-
versa.

- No section has been found in the series that does
not fail for the calculated forces. Applicable in the
case of steel joists and open web joists. In this
case, select a different section series.

• Top reinforcement:

- Insufficient section for negative moment. The com-
pressed zone does not resist the stresses produced
by the negative moment. Not even infilling will solve
this problem. The floor slab must be increased.

- Excessive negative moment. The forces exceed the
maximum that can be resisted by the manufactu-
rer’s joist sheet. The value of the moment is shown.
Solution: increase the floor slab depth or place a
double joist.

- Required top reinforcement area. The top reinforce-
ment has not been designed due to the excessive
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steel area required at the joist support (the program
designs the top reinforcement in this area based on
the moment at the support, in other words at the in-
ternal edge of the supporting beam). It is recom-
mended the thickness of the slab be increased.

- Top reinforcement outside of table. Applicable in the
case of generic joist f loor slabs and in situ
slabs.The negative reinforcement defined in the ta-
ble is not sufficient, but the program will calculate
the required reinforcement regardless. However, it is
recommended the floor slab depth be increased or
a double joist be placed instead of modifying the
reinforcement table.

- Infill greater than twice the depth. To avoid the bot-
tom reinforcement working in compression, since
the concrete is at its limit, an infill is provided, but
the program emits a warning when the infill exceeds
this length. Solution: increase the floor slab depth.

- Infill greater than 20% of the clear span. Same as
the previous case.

- Fixed or continuous ends in this type of joists are
not designed. Although steel joists are automati-
cally pinned at the edges, in the case of cantileve-
red joists, the program gives continuity to the inter-
ior panel to achieve local equilibrium. The negative
moment is not designed for.

- The calculated shear cannot be resisted. The calcu-
lated shear exceeds the capacity of the joist in the
sheet. Solution: increase the floor slab depth or
place a double joist.

7.2.1.4. Information

Click on the option Joists > Information then on the cho-
sen joist. The deflection and other information of the joist
will be displayed.

7.2.1.5. Assign

Allows to modify the designed bottom reinforcement of the
joist. Upon clicking on the Select button, the window will
close and the properties can be assigned to the selected
joist. To assign, click on Assign followed by the first joist
and then the last. The selected joists will be displayed in
yellow.

• Generic concrete joists. Allows to assign the bending
moment and the end shear forces to the selected joist
to, for example, to carry out a manual match of the mo-
ments and shears of the joists.

Fig. 7.44

• Reinforced concrete joists. Allows to modify:

- The type of joist within the series.
- The shear reinforcement.
- The partial forces. In three different ways: complete

length, length to be specified or by percentage
length. On screen and on drawings, these are al-
ways displayed as a percentage, regardless of the
way in which the reinforcement has been specified.

Fig. 7.45

• Prestressed joists. Allows to change the type of joist
within the series.

Fig. 7.46
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• In situ joists. Allows to change the bottom and shear
reinforcement. The length of the bars can be modified
as long as this modification does not imply that the bar
will extend past the external face of the beams. Up to
two longitudinal reinforcement bars can be specified.
In the case of shear reinforcement, the length of the bar
in the reinforced zone is converted into a number of
bars depending on their separation.

Fig. 7.47

• Steel joists. Allows to change the section within the
section series.

Fig. 7.48

• Open web joists. Allows to change the section to one
within the selected series for the chords or diagonals.

Fig. 7.49

7.2.2. Flat and waffle slabs

When flat slabs or waffle slabs have been used in the struc-
ture, a note will appear having analysed the job emitting the
following warning: ‘The program does not automatically check
the deflection of waffle and flat slabs. For these floor slabs, the
values of the elastic deflection can be consulted between any
two points indicated by the user. The limits in accordance with
the code selected for the job should be consulted and esti-
mate the corresponding deflections.’ See chapter 12. Con-
tour maps and deformed shape, for more information.

Additionally, if there are steel sections greater than those
introduced, a message will appear recommending the job
be recalculated.

7.2.2.1. Reinforcement introduction in flat and waffle
slabs without analysing

This option appears in the Analyse menu. Using this op-
tion, the program generates all the data required to intro-
duce, with the current geometry of the job, reinforcement in
flat slabs and waffle slabs without having to run a full analy-
sis. If the user proceeds with this option, all the reinforce-
ment of the job will be lost. Once the process has conclu-
ded, the reinforcement can be modified.
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7.2.2.2. Flat/waffle slab options in the Results tab

• Reinforcement views

Fig. 7.50

- Bar bending details. Only for sloped slabs. A ben-
ding diagram is drawn with the bar.

- Bending partial lengths. Only for sloped slabs. The
lengths of the bar on either side of the bending
point are detailed.

- Bending point mark. Only for sloped slabs. The
bend point is marked with a line perpendicular to
the bar axis.

- Add T.A. and B.A. text. These initials are added (top
and bottom additional) next to the corresponding
reinforcement.

- Flexure lines. Flexure lines that have been introdu-
ced are visible using the option Flat/Waffle Slabs
> Modify reinforcement > Define flexure lines.

• Modify reinforcement

Fig. 7.51

Modify diameter/spacing. In the window that ap-
pears, select Table and accept. A table will appear dis-
playing all the reinforcement combination packets defi-
ned within the table. A reinforcement package can be
selected and then assigned to the slabs. The contents
of the table may also be modified.

Fig. 7.52

It is not necessary to close the reinforcement window
whilst the modifications are being carried out, providing
a more comfortable and faster reinforcement solution.

Undo group. Bar grouping can be undone by clicking
on the bar group. Upon doing this, all the bars belon-
ging to the group are displayed.

Keep reinforcement view. This option causes the rein-
forcement activated in the Flat/Waffle slabs > Reinfor-
cement views menu to be visible and appear together
with the reinforcement selected to be modified. This

CYPE

85CYPECAD - User manual



way, for example, the bottom longitudinal reinforcement
can be seen whilst the top longitudinal reinforcement
can be modified.

• Save reinforcement copy of all groups

Using this option, a copy of the reinforcement of all the
groups can be saved. This is useful, for example, when
an unforeseen opening in the slab has to be introduced
and the user does not wish for the previously obtained
reinforcement to be lost. In this case, the reinforcement
must first be saved, the opening introduced, and then,
restore the reinforcement.

• Recover reinforcement copy of all groups

This option allows the user to recover reinforcement co-
pied using the option Save reinforcement copy of all
groups. Note that the reinforcement is only restored in
those areas where no geometrical changes have oc-
curred. The reinforcement is cut at the edge of new
openings, however anchorage hooks are not provided.

• Copy reinforcement from another group

Copies the reinforcement from one group of floors to
another. The user must first be located in the destina-
tion group. If the destination floor has a different geo-
metry to the master floor, the reinforcement shall only
be copied in the areas in which there is slab. The rein-
forcement is cut at the edge of new openings, but the
hooks are not provided. The angle and insertion point
of the grid must coincide. For this reason, it is recom-
mended that when defining a group of floors, to always
copy the group directly below it. Do not forget to check
the bars that have been cut: provide hooks, etc.

7.2.2.3. Add additional shear reinforcement around
drop panels

The new option Add additional shear reinforcement
around drop panels (Results tab, Flat/Waffle slabs >

Modify reinforcement > Punching shear reinforce-
ment > Add additional shear reinforcement around
drop panels) allows for groups of shear reinforcement
bars to be added in the ribs reaching a drop panel.

Fig. 7.53

When this option is selected, a dialogue box will appear in
which the number, diameter and spacing of the bars are to
be introduced.

Fig. 7.54

Having accepted the dialogue, the drop panel over which
the mouse cursor is placed will darken. Having made the
selection using the left mouse button, the chosen reinforce-
ment will be placed in the ribs surrounding the drop panel.

Fig. 7.55
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Fig. 7.56

The new bars will be added even if there are already shear
bars present in the ribs reaching the drop panel. If you wish
to substitute the existing bars for other bars, these must
first be deleted. To delete the existing reinforcement, use
the following option:

• Delete punching shear using a capture window

The option Delete group (Results tab, Flat/Waffle
slabs > Modify reinforcement > Punching shear
reinforcement) allows to delete the punching shear
reinforcement groups in flat, solid and waffle slabs one
by one or several at once by means of a capture window.

Fig. 7.57

7.2.3. Hollow core slabs

7.2.3.1. Hollow core slab views

Fig. 7.58

• Show bar bending detail. Only applicable to sloped
panels; the program draws a bending detail next to the
bar.

• Show bar bending mark. Only applicable to sloped
panels; the point at which the bar is bent is marked with
a dash perpendicular to the axis of the bar.

7.2.3.2. Hollow core plates catalogue

The program contains a manufacturer catalogue with pro-
perty data sheets of the hollow core plates. A table summa-
rising the properties is displayed in the job data report.

7.2.4. Composite slabs

7.2.4.1. Composite slab design

The design and analysis process is carried out in two
stages:

a) Construction phase

• To calculate the resistance of the profiled steel deck,
the following loads are taken into account: the weight of
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the concrete, weight of the deck, and the construction
loads. The construction loads represent the weight of
the workmen and equipment and any other loading that
may arise during the construction phase.

• To calculate the deflection, the construction loads are
not taken into account.

• A fixity coefficient of 0 between the panel and its sur-
rounding beams is considered internally (simply sup-
ported).

• An option is available to design the deck in case an ulti-
mate limit state or deflection limit is not verified or to
calculate the spacing of the shoring without having to
design the profiled deck.

b) Service phase

• In the service phase, the profiled steel deck has suppo-
sedly been designed in the preceding phase.

• The program assigns a fixity coefficient of 0 to all the
panels by default. Therefore with this load distribution
on the steel beams supporting the panel, no positive
moments arise in the intermediate supports. Once the
first analysis has concluded and the beams have been
designed, the user can modify the fixity coefficient (bet-
ween 0 and 1) and re-launch the analysis. If the user
assigns a fixity coefficient other than 0, there can be
two possible outcomes:

1. In the previous phase, a slab was designed which
did not require shoring and a deck verified all the
checks. In this case, the panel must only be analy-
sed with the additional load to be applied after the
construction phase, composed of dead and live
loads, since the steel deck supports the self weight
of the slab.
The way in which the program can take into ac-
count, in an approximate manner, only these loads

is by applying fixity coefficients, which the program
calculates and apples internally to adjacent panels.
As a guideline, the value of the fixity coefficient to
assign to the panels depends on the ratio between
the self weight of the slab and the total load, suppo-
sing the load distribution is uniform. The value of the
fixity coefficient would be:

Fixity coeff. = User’s fixity coeff × (1- (slab self weight
/ total load)).

2. In the previous phase, a slab requiring shoring was
obtained. In this case the program considers the to-
tal load in the service phase (permanent load + sur-
charge)

• There is an option available allowing the user to optio-
nally design the deck. The bottom reinforcement can
also be designed regardless of whether the deck has
been designed or not, or whether a suitable decking
profile has been found within those available. Either
way, if bottom reinforcement is used the collaborating
role of the deck is ignored.

• Whenever it is necessary to place reinforcement within
the depth of the concrete slab, at least one bar per rib
will be laid.

The resistance of a composite slab will be sufficient to sup-
port the design loads and assure that no failure limits are
reached. Failure methods include:

• Critical section I: Flexure: design value of the ultimate
bending moment at mid-span. This section can be criti-
cal if there is a complete connection at the interface bet-
ween the deck and the concrete.

• Critical section II: Longitudinal shear: the resistance
of the connection is decisive. The design value of the ul-
timate bending moment in Section I cannot be reached.
This situation is defined as a partial connection.
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• Critical section III: Vertical shear and punching shear:
design value of the ultimate shear force next to the sup-
port. This section will be critical only in special cases,
for example, in the case of slabs with a large depth and
small spans and relatively large loads.

The design value of a section’s bending moment resis-
tance is established using the plastic moment theory of a
section with a complete connection.

To obtain the effective area of the steel deck, the deck is
assumed to be smooth and uniform. This is the value indi-
cated in the properties sheet of the deck and validated by
the user.

The program calculates the design value of the resisted
positive moment of a composite slab depending on whe-
ther the neutral axis is situated above or within the steel
deck.

To calculate the longitudinal shear force, the design value
of the ultimate shear force, which is , partly, a function of
the ‘m-k’ coefficients, provided by the manufacturers of the
deck. This analysis is that which corresponds to slabs wi-
thout an end anchorage, i.e., shear studs on a composite
beam.

The design value of the resistant shear force of a compo-
site slab is found.

Punching shear is not analysed when concentrated loads
are applied.

Fissures in areas of negative moment are not analysed.

The Branson method is used to calculate the deflections,
as both the top and bottom reinforcements (be it the deck
or reinforcement) are known.

As indicated previously, the program checks and carries
out the design so that the deflection limits defined for the

construction phase are not overcome. This is done by in-
creasing the thickness of the deck or by shoring. In the ser-
vice phase, only the deflection is checked, CYPECAD does
not design the deck, and so, in this way, the deflection li-
mits defined for the service phase are complied with as
what avoids overcoming the limits is increasing the total
depth of the slab.

The specific reinforcement tables for top and bottom rein-
forcement are created. These can be accessed by clicking
on the bar options within the General data window in the
Job menu.

Within the menu Job > Floor slab options, there various
specific composite slab options similar to those of joist floor
slabs:

• Minimum ratios of top reinforcement in composite
slabs.

Fig. 7.59

• Minimum lengths of top reinforcement in composite
slabs.

Fig. 7.60

• Deflection coefficients - active deflection and total long
term deflection for composite slabs.

CYPE

89CYPECAD - User manual



Fig. 7.61

• Deflection limits for composite slabs.

Fig .7.62

• Composite slab parameters during execution. The follo-
wing options are available:

Fig. 7.63

- Uniform live load. The construction loads repre-
sent the weight of the workers and concrete equip-
ment, and take into account any impact or vibration
that may occur during construction. Over any rib,
and in a length of 3 m (or the span of the floor slab if
smaller), a load of 0.150 t/m2 is added to the weight
of the concrete (with the corresponding extra thick-
ness of concrete if ponding occurs), which repre-
sents the typical construction load and possible ex-
tra thickness (local accumulation). This load is pla-
ced at midspan to produce the maximum bending
moment, since the bay is simply supported during
construction. Over the rest of the rib, a typical load
of 0.075 t/m2 is added to the weight of the concrete.

- Dead and Live load factors. The partial safety fac-
tors for loads in building structures are: 1.35 for per-
manent loads and 1.50 for variable loads.

- Deck resistance safety factor. The partial safety
factor for the resistance of the ribbed deck must be
1.10 for the construction phase. Even if this coeffi-
cient is modified, the program will continue to apply
a value of 1.10 in the construction phase.

- Absolute deflection limit. Maximum deflection of
the deck its dead weight and the weight of the fresh
concrete (with the corresponding extra thickness of
concrete if ponding occurs). The program checks
and designs so that these deflection limits defined
for the construction phase are not exceeded, in-
creasing the deck thickness or placing shoring. In
the service phase, the program only checks deflec-
tion; it does not design the deck to meet these de-
flection limits, since this problem is solved by in-
creasing the total floor slab depth.

- Relative deflection limit ponding. Maximum rela-
tive deflection of the deck under its self weight and
the weight of the fresh concrete. If this limit, or the
‘Absolute deflection limit’, is exceeded, the program
recalculates the concrete weight, adding to the
thickness the deflection obtained multiplied by 0.7.
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• Design of composite slabs. The following options are
available:

Fig. 7.64

- Composite slabs (in construction phase). This
option refers to the analysis of the deck in the
construction phase, when it supports the load of
fresh concrete plus the execution live load by itself.
Select a section that will not require shoring in
the construction phase. If the option is not activa-
ted, the program does not design the deck in the
construction phase. If the deck placed by the user
does not meet an ultimate limit or service state, the
distance between shoring is calculated so that the
deck works. If the option is activated, the program
will design the deck in the construction phase. If the
deck placed by the user does not meet an ultimate
limit or service state, a deck that does will be selec-
ted. If the program cannot find a deck that works,
the deck placed by the user will be kept and the
distance between shoring will be calculated.

- Composite floor deck slabs. These options refer
to the analysis of a contributing deck, in which it
combines with the concrete to form a composite
deck:
Keep the selected deck and provide additional
reinforcement bars if it fails. The program
checks the deck resulting from the construction
phase. If it fails, the necessary bottom reinforce-
ment is designed.

Design the thickness of the deck. The program
checks the deck resulting from the construction
phase. If it fails, the program looks in the series for a
deck with sufficient thickness. If the option: If the
maximum section fails, provide additional rein-
forcement bars is activated, in case no valid thick-
ness is found in the series, the necessary positive
reinforcement is designed, keeping the deck resul-
ting from the construction phase. If the option is not
activated and no valid thickness is found in the se-
ries, a warning is emitted of the failure with the
Composite slabs > Errors option.

7.2.4.2. Composite slab results

• Views. Using this option, the data for the top and bot-
tom reinforcement can be configured on screen, as
well as the labels that will appear on screen and in the
drawings. Note that the bottom reinforcement is laid out
by rib, and the top reinforcement is distributed uniformly
over the whole width.

Fig. 7.65

• Errors. If there is an error in any section of the compo-
site slab, it is shown in red. To view the error message,
click on the marked section. A window is also available
with two buttons (Previous and Next) to sequentially
consult the panel errors.
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Fig. 7.66

• Information. The following information appears:

Name of the manufacturer, type of deck and total depth
of the slab.

If, having analysed, the panel requires shoring in its
construction phase, their maximum separation is indi-
cated.

The design span for the construction phase (if shoring
is required, this will be the shoring separation).

The deflection in the construction phase.

The total span in service phase (distance between sup-
ports).

Deflection in service phase. If this is too large, it is dis-
played in red. Recall that the program designs during
the construction phase so that the deflection limits and
strength of the deck are not exceeded (increasing
thickness of the deck or providing shoring), but in the
service phase, the deflection problem can only be sol-
ved by increasing the depth of the slab.

Fig. 7.67

• Assign deck (bottom reinforcement). Allows for a type
of selected deck to be assigned to one or various pa-
nels to, for example, carry out a manual match once
the job has been analysed.

Fig. 7.68

• Assign reinforcement (bottom reinforcement). Allows
for bottom reinforcement to be assigned to one or more
ribs to, for example, manually match or make the rein-
forcement uniform, once the job has been analysed.

Fig. 7.69

• Modify position (bottom reinforcement). The represen-
tation of the reinforcement of a slab width can be mo-
ved to another point within the same width. This can be
useful when the reinforcement label interferes with ano-
ther text.

• Delete reinforcement (bottom reinforcement). Deletes
bottom reinforcement.

• Modify (top reinforcement). This option allows to
change the spacing, diameter and length of bars. Rein-
forcement layers or groups can also be added or remo-
ved.

Once the bars to be modified have been selected, a
window opens indicating the different values depending
on the properties of the selected top reinforcement.

The lengths of the bars anchored as straight bars are
measured from the axis of the nearest beam. The
lengths of the bars with a hook anchorage indicate the
length from the bending point.
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• Assign (top reinforcement). Assigns
the type of selected top reinforcement
to one or more panels.

• Introduce (top reinforcement). Using
this option, the Current reinforce-
ment window will open. If it does not,
click on the right mouse button and it
will appear. The button Deflt. Lgths.
Allows for the lengths of the bars to
be introduced to be defined. Having
selected the reinforcement and ac-
cepted the dialogue box, select the
initial reinforcement introduction point
on the panel and drag to the final point.

• Delete (top reinforcement). Deletes the selected top
reinforcement.

• Modify position (top reinforcement). Allows to move
the representation of the reinforcement of a slab width
to another point within the same width. This can be use-
ful when the reinforcement label interferes with another
text.

• Panel data. This option is exactly the same as the Pa-
nel data option in the Beam Definition tab.

Fig. 7.72

7.2.5. Force diagrams

In the Envelopes menu from the Results tab, the options
Forces in joists, Forces in hollow core plates and For-
ces in composite slabs. These options allow for the force
envelopes (Moment, Shear and Torsion), loadcases or
combinations to be consulted.

If the Loadcase or Combination option is selected, a
scrolling menu appears from which the desired loadcase or
combination can be selected. If a dynamic earthquake
loadcase is selected, another scrolling menu will appear
from which the Vibration modes of the structure can be
selected.

Having accepted the dialogue box, by clicking with the left
mouse button on the beam alignments, joists, hollow core
slabs or composite slabs, the forces or force diagrams can
be consulted.

7.3. Drawings and Reports

7.3.1. Composite slabs

7.3.1.1. Reports

The following composite slab reports may be obtained:

Forces in composite slabs

Composite slab takeoff

Composite slab reinforcement
takeoff

Fig. 7.73

Fig. 7.70

Fig. 7.71
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Fig. 7.74

The slab data may be viewed in the Job data report and
the material quantities in the Job takeoff.

7.3.1.2. Drawings

Within the configure option of the Floor plan, a tab label-
led composite slabs can be selected and within which all
the elements relative to the composite slabs can be found.

Fig. 7.75

7.3.2. Joist floor slabs

7.3.2.1. Report of forces in joist floor slabs

Draws the moment, shear and torsion envelopes of
any joist alignment. As well as the force envelope
drawn in red, a diagram of the floor group and the joist
in question are provided for each floor group.

7.3.2.2. Joist floor takeoff

The joist reinforcement weight and takeoff per metre
length (including fabrication loss) can be obtained. The

top, bottom and shear reinforcement in the case of insitu
joists is measured (regarding the shear force, the total
length or the omega shaped reinforcement is provided).

7.3.3. Sloped panels

The drawings are obtained via the following route: File >
Print > Job drawings > Floor plans.

The value of the tangent of the slope is attached to the ele-
vation text on the inclined slope. A diagram of the floor can
also be provided. Within the Others tab in the Drawing
configuration option, the option Floor layout can be
found (only available if there are sloped slabs) where the
size of the diagram in which the columns, beam axes and
slope arrows are displayed can be established.
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8.1. General information
The Stairsmodule analyses and designs the reinforcement
of stair slabs as isolated elements of the structure. Depen-
ding on the geometry, the type and the layout of the sup-
ports and the applied gravitational loads, the program esta-
blishes the reactions on the main structure which are trans-
mitted as line and/or surface loads as dead and live loads.

The program considers the staircase to be composed of
spans between floors containing landings of the following
types:

Straight flight

Two straight flights with half turn landing

Three straight flights with quarter turn landings

Two straight flights with full turn landing

Two consecutive flights with intermediate landing

‘n’ straight flights with half turn landings

‘n’ straight flights with quarter turn landings

The program interprets the “staircase” as the group of
stairs spanning between floors defining the vertical circula-
tion of a specific area of the building. The “flight” is the incli-
ned part of a stair formed by a continuous succession of
steps covering the elevation change between two horizon-
tal planes.

The intermediate landing is the intermediate horizontal
plane between two consecutive flights.

8.2. Location of Stairs module
The options relative to stairs are located in the Stairs floa-
ting menu, accessed by clicking on Job > Stairs in the
Beam Definition tab.

Fig. 8.1

These allow the user to:

Create a new staircase

Edit existing staircases

Delete staircases

Move a staircase

Rotate a staircase

View reinforcement details of all the spans of a stair-
case

View forces and displacements using contour diagrams

8. Stairs
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8.3. Data introduction in the Stairs module

8.3.1. Create a new staircase

By clicking on the icon from the Stairs floating menu,
the New Staircase dialogue box appears.

Fig. 8.2

The window contains two tabs. In the Staircase data tab,
the common properties of the staircase assembly can be
defined and in the Spans tab, the properties of each span
between floors.

The program considers the new staircase to start at the
current group, the name of which appears in the top right
hand corner of the dialogue box.

8.3.1.1. Staircase common data

In the Staircase data tab, the geometric properties and
loads of a new staircase are defined.

These properties are common to all the spans belonging to
the staircase. If the case arises that part of a staircase
contains particular data or possesses different values (dif-
ferent loading, for example), then it must be introduced as
two separate staircases.

Geometric properties

• Width

The width of the stair or length of the risers.

• Tread and Riser

The tread is the width of the step measure on plan and
the riser the vertical distance between two consecutive
treads (height of the step).

• Rotation

Left or Right may be selected depending on the rota-
tion direction the person takes when going up the stair.

• Layout of last step

The last step of an ascending flight can have one of two
different layouts:

The intermediate landing or landing form the
last step.

The last step is situated on the inclined slab.

Loads

• Steps

The step construction method (Poured with concrete
slab or Using bricks). This information affects the cal-
culation of the dead loads applied to the stair and when
measuring the quantity of concrete used for its
construction.

• Handrail, floor and live loading

The required weight of the handrails is the total weight,
therefore the user has to introduce the data taking into
account if there are one or two handrails.
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8.3.1.2. Staircase flight data

The flights of the staircase are the panels that join one floor
with another and can contain one or more spans. The pro-
perties defined for the flights can be different from each
other (slab thickness, initial elevation, layout, number of
steps etc.).

In the program, the flights of a staircase are defined by se-
lecting the Spans tab in the New staircase window. Ha-
ving selected the tab, the following window will appear:

Fig. 8.3

In this window, flights may be attached by clicking on the cor-
responding icon, which will open the Flights dialogue box:

Fig. 8.4

New flight types may be added by choosing amongst
those predefined by the program from the Type scrolling
menu or, alternatively, a new flight can be created by
clicking on the icon. Upon clicking on this icon, a new
window Create [Stair types] window appears in which the
properties of the new type are defined.

The group of types forms part of the job library, and there-
fore a type of flight can be used more than once in a stair-
case and in more than one staircase of the job.

The program also allows for staircases that have been defi-
ned in one job to be used in another using the library ma-
nager, which allows for types to be imported and exported.

In the Create [Stair types] dialogue box, the following
data is specified:

• Reference of the stair type

Identification of the defined flight

• Slab depth

The depth of the slab can be proposed by the program
or set by the user.

For the program to be able to pre-design the depth of
the slab, do not activate the Slab depth box; the pro-
gram will then assign a depth whose value is 1/30 of the
true maximum span between supports.

When the Slab depth box is activated, the user has to
introduce the value for the depth of the stair slab.

• Start level difference

It is possible to indicate an elevation change (greater or
equal to 10 cm) at the start of each staircase flight due
to the eventual depth of the slab.

An example of the where this value can be applied, is in
the case of a staircase starting at the foundations and
must cross a raised floor slab or screed.
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• Initial steps built on floor

If there are steps built on the floor at the start of a span
of stairs, the number of steps must be indicated. Once
the stair has been calculated, the program applies a
uniform surface reaction to the main structure corres-
ponding to the mean load of the steps built on the floor
and introduces it as a dead load. The program does
not generate the live load that may occur in the area ta-
ken up by the built steps as this element is located on a
structural element (for example, a slab) that already has
a live load applied to it.

• Span and landing layout

Select one of the types to be introduced.

• Number of steps

Depending on the type of stair that has been selected,
the program will ask for the number of steps of each
slab making up the flight.

• Stairwell width

This is only required if there are half turn landings.

• Steps built on intermediate landing

If there are any, the number of steps is required.

• Intermediate landing supports

Intermediate landings can be supported or free.

If supported, the location of the supports must be spe-
cified: Front, Lateral, Both

Type and width of support. The program allows the
user to choose amongst the following supports:

- Hanging bar: these are bars that hold the edge of
the landing by means of a structural element
(usually a beam) situated on the floor above the lan-
ding. The program requires the width to be able to
consider the weight of the brick wall situated bet-
ween the landing and the floor above.

Masonry wall (*)
Concrete wall (*)

(*) Its load is applied on the structural element situated
under the supported edge of the landing on the floor below.
The self weight is taken as the load of a wall of a given
width and of height equal to the level difference between
the intermediate landing and the floor below. A specific
weight of 15.70 kN/m3 is taken for the case of a masonry
wall and of 24.53 kN/m3 for the case of a concrete wall. If
there were to be a wall spanning between the intermediate
landing and the floor above, or any other type of partition or
external wall, the user must apply the line load on the floor
below corresponding to the load of the aforementioned ele-
ment.

- Connectors: these are shear connectors joining
the intermediate landings to structural elements
such as a beam or wall, to which the end reaction is
transmitted.

Having accepted the Create [Stair types] dialogue box,
the program returns to the Flight window where the num-
ber of Equal consecutive flights is required, that is, the
number of consecutive floors of the staircase that contains
this type of flight.

Fig. 8.5
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Fig. 8.6

Once these values have been defined, the program returns
to the New staircase window, which will display the new
flight that has been defined.

Fig. 8.7

Within this window, the number of consecutive equal flights
can be defined.

Any number of flights can be defined following the same
procedure. Additionally, a new flight can be defined by co-
pying the data of a previously defined flight using the
icon at the top of the list.

Fig. 8.8

In section 8.3.1.4. Tools to facilitate staircase and flight
definition, there are several interesting indications which
may result useful when defining new staircases and flights.

8.3.1.3. Introduction of the staircase in the job

Once all the data (common and specific to each flight) of
the staircase has been defined, all that is required is to po-
sition the staircase on the current floor.

To introduce the staircase, click on Accept in the New
staircase dialogue box. The program will display the cur-
rent floor on screen and will draw the first flight of the stair-
case to be introduced next to the mouse cursor.

Fig. 8.9
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The staircase moves with the cursor and will remain at a
fixed position upon clicking on the left mouse button. To
help situate the start of the staircase, object snaps can be
used with a DXF or DWG template.

Fig. 8.10

Having positioned the start of the staircase with the left
mouse button, the staircase rotates around the selected
point.

Fig. 8.11

Upon clicking, once again, on the left mouse button, at
another point that will define its direction on the floor, the
staircase will be introduced.

Fig. 8.12

Object snaps to an imported DXF or DWG template or in-
troduction using the orthogonal mode, are very helpful tools
when introducing the staircase.

Once the staircase has been introduced, the program al-
lows for new staircases to be introduced identical to that
previously introduced, whose references are numbered
consecutively. Click on the right mouse button to finish in-
troducing the staircases.

If a geometric error arises when introducing the staircase,
the program will display an error message on screen.

Fig. 8.13

The user can visualise the staircases introduced in the job
using the 3D view ( Groups > Building 3D View or Floor
3D view), allowing the user to check the data introduction,
shape, if there is any interference with surrounding ele-
ments, etc.
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8.3.1.4. Tools to facilitate staircase and flight defini-
tion

Copy staircase
There are structures which contain the same or similar
staircases, therefore, it is very useful to be able to use the
data of an already introduced staircase to create a new ele-
ment.

For this reason, CYPECAD retains the data of the last intro-
duced staircase whilst another job is not selected or the
user exits the program.

Additionally, the program allows for, upon introducing a
new staircase, to copy the data of a previously introduced
staircase which is visible on the current floor. To do so, ha-
ving clicked on the icon from the Stairs floating menu,
select the Copy from button.

Fig. 8.14

Upon clicking on Copy from button, the current floor is dis-
played so the user can select the staircase to be copied
using the left mouse button. The program will then return to
the dialogue box where the user can check that the data of
the selected staircase has been copied, including all that
belonging to its flights. This data can then be modified, if
necessary, to adapt it to the new staircase to be introduced.

An example highlighting the advantage of the Copy from
option can be seen in the case of structures with symmetri-
cal staircases. In this case, one of the staircases is defined
and introduced. The second staircase is copied from the
first and the ascending rotation is modified; with this the
staircase is completely defined and all that is left to do is in-
troduce it in the structure.

Predefined types of stair flights
When a new flight is introduced in a staircase (Spans tab,
clicking on the button), the Flight dialogue box appears
and whereby pressing the button, new types of flights
can be added. Alternatively, instead of defining a new flight,
one may be selected amongst those listed in the Type
scrolling menu.

Fig. 8.15

The types displayed in the list are the predefined types as
well as those defined by the user.

The type of flight can also be selected from the scrolling
menu in the New staircase dialogue box.
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Flight copy within the same staircase
A new flight can be introduced by copying a previously in-
troduced flight belonging to the same staircase. This is
done using the Copy selected element and add it to
the list button located at the top of the New staircase
dialogue box.

Fig. 8.16

When this order is executed, a new flight with the same
properties as that which was selected is created at the top
of the list. This implies that physically, the new flight is situa-
ted above those flights previously defined in the staircase.

This tool is very useful to add flights with similar properties
to the staircase.

Copy and edit types of stair flights
To manage the flight types, the Copy and Edit
tools can be used. These are located at the top right hand
corner of the New staircase dialogue box and at the top of
the Flight dialogue box.

Fig. 8.17

The Copy button repeats the properties of the type dis-
played in the drawing in another new type which the user
must assign a new reference to. This allows for similar flight
types to be created quickly.

The Edit button allows for the selected type to be modi-
fied. If the type to be edited is being used in another stair
span, the edit function is blocked to avoid an involuntary
modification from being carried out on other flights. If the
type is not used in any other span, there are no modifica-
tion restrictions.

Fig. 8.18
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If the user wishes to edit the type, and therefore, modify
other stair types, the lateral button Blocked edition must
be clicked on, so to unblock it.

Fig. 8.19

Stair flight library
The types of stair flights can be saved in a library andsub-
sequently used in other jobs. This way, jobs with similar
stair flights can share data without the need of having to
reintroduce them. The tool that manages the types library
is activated by clicking on the Library Manager button

, situated at the top right hand corner of the Flight
dialogue box.

Fig. 8.20

The library can be managed in such a way that flight types
defined in the job can be exported to the user library so
that these can then be imported later on in other jobs.
The use of the library management buttons is described by
means of a tool tip when the cursor is placed over them.

8.3.2. Edit existing staircases

To edit the data of existing staircases in the job, click on the
button of the Stairs floating menu, followed by a click

on the selected staircase. The program will display the Edit
staircase dialogue box.

Fig. 8.21

8.3.3. Delete a staircase

To delete one or several staircases click on the button
from the Stairs floating menu and then click on the stair-
case to be deleted, or by means of a capture window, se-
lect the staircase or staircases to be eliminated.
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8.3.4. Move a staircase

To move a staircase, click on the button from the
Stairs floating menu followed by a click with the left mouse
button on the staircase to be moved, marking a point which
will be taken as the reference point for its new position. Use
of object snaps to DXF or DWG drawings may be useful
when establishing the new position of the staircase.

8.3.5. Rotate a staircase

To rotate a staircase, click on the button from the
Stairs floating menu. Select the staircase to rotate using
the left mouse button. The program will display the stair-
case pivoting around the start point of the flight in the cur-
rent group. There are two ways to define its rotation: by se-
lecting a point on screen defining its new direction or by
clicking on the right mouse button and introducing the an-
gle in the dialogue box that appears on screen.

Fig. 8.22

8.4. Results, reports and drawings of the
Stairs module

8.4.1. View staircase reinforcement details

Click on the button from the Stairs floating menu, follo-
wed by a click with the left mouse button on the staircase to
view its reinforcement. If it is the first time the staircase has
been selected or modifications have been carried out since
the last analysis, the program will proceed to design and
reinforce it. Once the staircase has been designed, a win-
dow will be appear displaying the reinforcement of each
flight making up the staircase.

To view the reinforcement of other flights of the staircase,
click on the scrolling menu situated at the top left hand cor-
ner of the window.

8.4.2. View forces and displacements using contour
maps

The program designs the stairs in an isolated manner and
by finite element method, taking into account the usual
loadcases in the design of staircases: dead and live loads.

To view the forces and displacements of a staircase click
on the button from the Stairs floating menu, followed
by a click with the left mouse button on the staircase whose
results you wish to consult. If it is the first time the staircase
is selected or if changes have been carried out since the
last analysis, the program will design it. Once the staircase
has been designed, a window displaying a three dimensio-
nal view of the stair flight will open. The displacements and
forces of the selected flight can then be consulted.

8.4.3. Staircase design

Staircases can be designed using any of the following me-
thods:
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• When analysing the job:

When the job is being analysed, all the staircases are
also designed, so that its reactions can be applied to
the main structure. Therefore, the first thing the pro-
gram analyses are the stairs.

• Using the or icons from the Stairs floating
menu:

If the job has not been analysed, each staircase can
be designed individually upon selecting the or
buttons and clicking on the staircase for the first time.

If the user modifies the staircase once the job has been
analysed and these changes affect the reactions of the
staircase on the structure, a new analysis should be
launched so that these modifications are taken into ac-
count. The program warns of this situation.

8.4.4. Reports

Added to the list of job reports, is the option to generate a
report of all the staircases introduced in the job.

Fig. 8.23

The stair reports contain the general data of all the stair-
cases of the job (materials and code used), common data
(geometry, loading, etc.) and specific data (reactions on

the main structure, reinforcement, resultant forces in each
span section) of each flight.

8.4.5. Stair drawings

Added to the list of job drawings (Beam Definition, File >
Print > Job drawings) is the option to create stair detail
drawings of each of the staircases of the job.

Fig. 8.24

Fig. 8.25
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The drawings display all the required information to define
the stair layout: longitudinal and transverse sections, pro-
perty tables of each span with its geometric data, loads
and materials. The reinforcement takeoff tables are also in-
cluded (per staircase, flight and total steel summaries).

8.5. Stair module configuration (materials,
reinforcement tables and stair options)
The concrete used for the stairs is the same as that defined
for floors and is defined in the General data dialogue box
(General data found in the Column Definition, Beam
Definition or Results tab).

By pressing on the By position button of this dialogue
box, another dialogue box opens (Steel types in bars)
from which the steel to be used can be selected and the
reinforcement tables to be used to reinforce the staircases
can be managed.

Fig. 8.26

Similarly, the Stair options button is added whereby the fol-
lowing options and data is configured:

Fig. 8.27

Options
• Match top and bottom reinforcement

Having analysed the job, the program assigns the maxi-
mum reinforcement value to both reinforcements.

• Design the top and bottom reinforcement with self
factored separations

Activating this options implies the program will lay the
reinforcement in such a way that their separations will
be multiples of each other. For example, one at 10 cm
and the other every 10 cm or 20 cm.

• Match reinforcement of all sections

If the option is activated, the program assigns the maxi-
mum reinforcement value to all the sections (longitudi-
nal and transverse) of the same flight of stairs. All the
top reinforcement is matched and then the bottom.

• With starter bars at the start

• With dowel bars at slab end

Data
• Length available to anchor in slab

This value indicates the available room to anchor the
anchorage bars of the first flight using a flat beam. If a
greater anchorage length is required, the anchorage
bars will be bent. If the width of the flat beam is greater
than that indicated in this option, the width of the beam
will prevail as the space available for anchorage.
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• Geometric cover (also referred to as nominal co-
ver)

The cover of the reinforcement closest to the external
edges of the slabs should be indicated depending on
the aggressiveness of the type of environment where
the stairs are situated.

• Foundation depth

This value is used to define the anchorage of flight
starts at foundation level when a foundation element
does not exist below the stair start.
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As well as steel beams and columns being introduced in
the job, CYPECAD offers further options regarding non-
concrete structures. These include the possibility of incor-
porating Integrated 3D structures to the job and steel joint
design.

9.1. Integrated 3D structures
The option Integrated 3D structures has been included
in the Job menu, which allows for three dimensional steel,
timber or aluminium structures made up of nodes and bars
with six degrees of freedom to be defined and connected
within the project being edited at the time. This option al-
lows for several 3D structures to be added to the same
project.

Upon activating this option, a dialogue box appears contai-
ning the following options to introduce 3D structures.

Fig. 9.1

9.1.1. Integrated 3D structures menu

Upon selecting any of the options within the menu, the pro-
gram displays the steps that are to be followed in the bot-
tom part of the screen (below the Column Definition tab,
Beam Definition tab….). The user also has help available
within the dialogue box where the options appear.

New Structure

The connections that are going to be defined of the 3D
structures have to be located and marked in the project.

The connections are the points where the integrated struc-
ture is ‘attached’ to the structure in CYPECAD and they
should be situated at columns, and if no column is used as
a connection point as in the case of beams or a floor slab,
a start should previously be introduced at that point.

Once the option has been activated, upon approaching a
column, it can be snapped to and having done so, a red
point will appear with floating message. The message indi-
cates the reference of the snapped column and the X and Y
displacements with respect to the centre of the column as
well as its elevation change with respect to the level of the
floor group, whose default value is 0.

If the elevation of the connection compared to that of the
group is to be modified, click on the right mouse button
and the following dialogue box will appear:

Fig. 9.2

Fig. 9.3

The previous figure displays the options to modify or
change the group if the 3D structure is connected to more
than one group. Upon clicking on the left mouse button the
connection will be introduced.

If all the connections have been defined, click on the right
mouse button and select the option Validate connections,
the connections will be saved and Metal 3D will open to in-
troduce the structures.

9. Steel, timber and aluminium structures
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Edit structure

Select the structure to be edited, upon approaching the
cursor to a structure, it will be displayed in yellow and by
clicking on it with the left mouse button, Metal 3D will open
for its edition.

Delete structure

Works in a similar way as the previous option. Deletes the
selected structure.

Move structure

The user can change the position of an integrated 3D
structure by selecting this option, clicking on the structure
and moving it to its new position.

Copy structure

This option allows users to create a new integrated 3D
structure in the current group based on one which has pre-
viously been introduced in another group.

Rotate structure

This option allows users to rotate an integrated 3D struc-
ture. It can be rotated in two ways:

• By indicating the numerical value of the angle

- Select the integrated 3D structure to rotate
- Select the rotation point
- Select the rotation angle

• Graphically using reference points

- Select the integrated 3D structure to rotate
- Select the rotation point
- Select a reference point
- Select any point of the straight line joining the rota-

tion point with the future position of the selected re-
ference point.

The rotation point and reference point do not have to be
points of the structure. The program provides a provisional
display of the integrated 3D structure as the mouse cursor
is moved after the reference point has been selected and
before selecting its future position.

If horizontal loads are present, such as wind loads, the pro-
gram analyses and manages the rotation of these loads to-
gether with the rotation of the integrated 3D structure. The
program will ask the user to confirm different actions, de-
pending on whether the structure has or has not got any
loads included in a loadcase used by other integrated 3D
structures or in the job in CYPECAD:

• The horizontal loads of the integrated 3D structure
to be rotated act in a loadcase not used by other
integrated 3D structures or by the job in CYPECAD

In this case, the program asks the user to define how
these loadcase combine with one another and with
other horizontal load loadcases of the same type (wind,
for example) that may exist in the structure of CYPECAD
or in other integrated 3D structures. The program’s de-
fault option is set so these loadcases are analysed as
independent loadcases, i.e. they do not act simulta-
neously with the others.

• The horizontal loads of the integrated 3D structure
to be rotated act in a loadcase are also used by
other integrated 3D structures or by the job in
CYPECAD

The program asks the user to choose between the follo-
wing:

- Keep the horizontal loads of the integrated 3D struc-
ture to be rotated in their current loadcase and
check whether they are valid later on.

- Apply the horizontal loads of the integrated 3D
structure to be rotated in new loadcase combina-
tions created automatically by the program.
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In either case, the program then displays a dialogue box
where the loadcases can be combined, similar to when the
loads of an integrated 3D structure to be rotated belong to
a loadcase not used by other integrated 3D structures or
by the job in CYPECAD.

Align structure

This option allows users to align an integrated 3D struc-
ture. The aligning of a structure consists of a displacement
and a rotation. An integrated 3D structure can be aligned
by selecting two reference points and indicating its new po-
sition. The reference points do not necessarily have to be
points of the structure. The procedure is as follows:

• Select the integrated 3D structure to align

• Select the first reference point

• Select the new position of the first reference point

• Select the second reference point

• Select any point of the straight line which will join the
new positions of the reference points.

The program provides a provisional display of the integra-
ted 3D structure as the mouse cursor is moved after the re-
ference point has been selected and before selecting its
future position.

If horizontal loads are present, these are dealt with in the
same manner as in the case of the Rotate structure option
(described in more detail above).

New connection

This option allows for connections to be added to a pre-
viously introduced 3D structure. To do so select the struc-
ture, followed by the connections on the columns or starts.
Once all the new connections have been introduced, click

on the right mouse button and select the option Add
connections.

Delete connection

Allows to delete connections of a previously introduced 3D
structure. To do so, select the connections to be deleted.
When connections are deleted, they are transformed into
nodes of the 3D structure, which should be eliminated if
they are not required.

Move connection

Allows for previously introduced 3D structure connections
to be moved. To do so, select the connection to move and
click on its new position. Be aware that when a connection
is moved, a node will be generated at its original position.

Connection information

Using this option, information of the connection is dis-
played: absolute elevation and elevation change with res-
pect to the floor group to which it connects.

Assign elevation change

Upon selecting this option, a dialogue box appears in
which the elevation change to be assigned to other
connections is to be introduced. Using the Select button,
the same elevation change assigned to another connection
can be assigned to other connections.

List of integrated 3D structures

This option allows to view and edit all the 3D structures wi-
thout the need of having to find them in the CYPECAD job.
Upon activating it, a new dialogue box opens displaying a
list with the structures integrated in the job. To the right of
the dialogue, a representation of the selected structure can
be seen.



Fig. 9.4

9.1.2. Metal 3D program

External fixity
The External fixity option in Metal 3D allows to specify if the
bars reaching the introduced connections in CYPECAD are
‘fixed’, ‘pinned’ or ‘?’.

Introduction of load states
Loadcases are defined using the option Additional load-
cases (special loads) in the General Data dialogue box of
CYPECAD. If a new loadcase is to be defined, the user
must return to CYPECAD to define it.

Predesign the structure
It is necessary for the structure to be predesigned before
carrying out a joint analysis of the CYPECAD project. If this
is not done, the force results could vary greatly due to
considerable changes in the inertias of the bars of the 3D
structures compared to what was obtained in a previous
analysis, if they are not correctly predesigned.

• Analyse the isolated structure. This option allows to
carry out a quick analysis of the forces in the isolated
structure. This analysis will allow to carry out a fast des-
ign of the structure. In the analysis, any interactions with
CYPECAD are not taken into account, this is why once

the preliminary design has been carried out, the whole
project has to be analysed from the Beam Definition tab
in CYPECAD.

• Design with current forces and using all the sections of
the series. This and the following options allow to des-
ign the structure using the forces obtained in the option
Analyse the isolated structure or with those obtained
from analysing the entire CYPECAD project. These al-
low to consult the connection reactions.

Once the structure has been predesigned, the user returns
to CYPECAD where a global analysis of the project will be
carried out. Then, once it has been analysed, the user is to
return to Metal 3D to verify the bars using the forces obtai-
ned from the global analysis of both structures. In those
cases where the inertias of the bars vary greatly, the struc-
ture will have to be reanalysed using CYPECAD.

Baseplates

• Generate. This option generates the baseplates of the
connections defined in the Beam Definition tab of CY-
PECAD on concrete columns or starts, which can be
steel or concrete.

• Edit. Within the baseplate dialogue box which appears
during the edition, the option Design can be found.
This option satisfies the parameters indicated in the ba-
seplate option within the General data dialogue box in
CYPECAD, which will propose a modifiable solution.

9.2. Joint design
The program incorporates the analysis and design of
connections for rolled and welded steel I sections for va-
rious design codes (please consult our website for the avai-
lable design codes. If the design code with which the job is
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being designed is not yet available with the Joints module,
the user can opt to copy the job and design them using a
different code).

9.2.1. Types of joint design

The program offers several options for connection design:
the Joints modules.

The following Joints modules are currently available with
the program:

• Joints I. Welded. Warehouses with rolled and welded
steel I sections

• Joints II. Bolted. Warehouses with rolled and welded
steel I sections

• Joints III. Welded. Building frames with rolled and wel-
ded steel I sections

• Joints IV. Bolted. Building frames with rolled and welded
steel I sections

• Joints V. Flat trusses with hollow structural steel sec-
tions

New modules will be coming soon; check our website for
new implementations.

9.2.2. Joint Design

If nodes whose type of joint is resolved in the program are
detected during the design process of the structure, the
program will design the connections and will provide a de-
tail drawing of the results.

• For I sections (Joints I, II, III and IV modules), the pro-
gram provides two types of design:

Welded, e.g.:

Fig. 9.5

Fig. 9.6

Fig. 9.7

Fig. 9.8

CYPE

CYPECAD112



Fig. 9.9

Fig. 9.10

For a more complete list of available welded connections,
please consult the corresponding website at

www.cypecad.en.cype.com/joints_welded.htm and

www.cypecad.en.cype.com/joints_welded_building.htm

Bolted (using ordinary or prestressed bolts), e.g.:

Fig. 9.11

Fig. 9.12

Fig. 9.13

Fig. 9.14

Fig. 9.15
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Fig. 9.16

For a more complete list of available bolted connections
please consult the corresponding website at

www.cypecad.en.cype.com/joints_bolted.htm
www.cypecad.en.cype.com/joints_bolted_building.htm

The program will design the required weld thicknesses and
incorporates stiffeners if they are required for the correct
transmission of forces. Additionally, in the case of bolted
connections, the optimum layout of prestressed or ordinary
bolts is provided.

• For flat trusses with hollow structural sections:

The hollow structural sections must consist of welded
sections with the additional condition that the bar acting
as the truss chord must be a continuous bar, in the
case of an intermediate node. The hollow structural
sections are designed so to meet all the requirements
indicated in the selected code. The program represents
the edge preparation of the tube ends to be able to
weld the sections correctly.

e.g.:

Fig. 9.17

Fig. 9.18

Fig. 9.19

Fig. 9.20

Fig. 9.21
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Fig. 9.22

For a more complete list of available hollow structural sec-
tion connections please consult the corresponding website
at

www.cypecad.en.cype.com/joints_flat_trusses_hollow_stru
ctural_sections.htm

9.2.3. Consulting the designed joints

The joints can be designed at the same time as the general
analysis (by marking the Design joints box in the Analysis
dialogue box).

To then consult the designed joints, click on Joints > Con-
sult. Upon activating this option, all the joints which have
been designed by the program will be marked with a green
circle. Those that have not been resolved will be marked
with a red circle. Joints which are partially resolved i.e.
containing connections that have been designed and
others that have not will be marked in an orange circle.

If the mouse cursor is brought close to a node in which
there is a designed joint, the joint will be highlighted in blue
and an information window will appear indicating the type
of connections associated to that node that are present.
By then clicking on the joint, the detail drawings of the
connections associated to that node are displayed.

Fig. 9.23

Fig. 9.24

If the cursor is brought close to a node in which there are
connections that have not been designed but belong to
one of the types recognised by the program, an information
window is displayed providing the reasons why the joint
has not been designed.



9.2.4. Reasons why a joint has not been designed

If the program does not design a joint, which initially ap-
pears to correspond to one implemented in the program, it
may be due to one of the circumstances explained below:

a. Section fixed to the web of another section

If a section is to be fixed to the web of another section,
the connection cannot be solved. Bar ends connecting
to the web of a section must always be a pinned
connection.

b. Interference between sections and stiffeners

If the section joining to the web of another section inter-
sects with the stiffeners placed by the program to gua-
rantee the bars reaching in the orthogonal plane are
fixed.

c. Thickness of the elements

If the necessary throat thickness of the weld is greater
than 0.7 times the thickness of the joining element.

d. Orthogonal elements

If the webs of the bars are not contained in the same
plane or are not perpendicular to one another, the pro-
gram will not resolve the joint.

e. Angle

If the previous point is complied with, the angle bet-
ween the surfaces of the bars to be welded must be
greater or equal to 60º, otherwise the joint is not des-
igned.

Fig. 9.25

9.3. Export to other programs
CYPECAD allows for the designed steel structure to be ex-
ported so it may be viewed and modified in other pro-
grams. The Export options are located in File>Export. The
programs include Tekla Structures and TecnoMETAL 4D.

Additionally, the option exists to export in CSI/2 format.
CIS/2 (CIMsteel Integration Standards) is a standard inter-
change format to facilitate data flow between applications
which intervene in the analysis, design and fabrication pro-
cess of steel structures. CYPECAD and the Integrated 3D
structures of CYPECAD can export the introduced and des-
igned structure in CIS/2 format, advised by the NIST (Natio-
nal Institute of Standards and Technology) so it may later be
use in programs such as Graitec Advance Steel.

Fig. 9.26

External loads acting on the structure can be introduced in
CYPECAD or the Integrated 3D structures, so to obtain its
optimum design in accordance with the selected code. Ad-
ditionally, the construction details of bolted and welded
connections of rolled and welded I sections that are gene-
rated can also be exported to other programs and obtain a
3D model of the whole in that program.
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There are two options when exporting:

• Only geometry and properties of nodes and bars.
Exports the geometry and steel sections recognised by
the program it is being exported to. The structure does
not have to be analysed or designed before it is expor-
ted. It does not include the export of joints and so these
do not have to be designed before exporting either.

Fig. 9.27

• Complete detailing of the structure, including
joints. Exports the geometry of the job, the steel sec-
tions recognised by the program it is being exported to
and the joint detailing corresponding to the steel ele-
ments. The job and joints must be analysed before ex-
porting.

Fig. 9.28

Please consult our web-site for the minimum program re-
quirements to use these options.
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10.1. Loads to be defined in General data

10.1.1. Actions

10.1.1.1. Wind loading

Wind action can be specified in the General data dialogue
box by selecting the With wind box in the Loads section.
When selected, a new dialogue box will appear where the
code to follow and properties can be specified. The data to
be entered will vary depending on the chosen code, howe-
ver, all require the tributary widths and load coefficients in
the X and Y directions to establish the correct wind coeffi-
cient. The analysis may be carried out with or without se-
cond order effects. If the code that is sought is not availa-
ble, the user has the option to use a Generic Code.

Fig. 10.1

10.1.1.2. Seismic loading

Earthquake loading can be specified by selecting theWith
seismic loading box. The dialogue box that appears is si-
milar to that of the wind action whereby a list of codes is
displayed on the left hand side of the box and their specific
data, which will vary depending on the selected code, is
entered on the right. A generic code is also available, only
here, it is presented as a Modal spectral analysis or by
specifying the load Coefficients per floor that have to be
applied. The option to analyse with or without second order
effects is also available.

Fig. 10.2

10. Loads
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10.1.1.3. Fire resistance

A fire resistance check is available, however this is underta-
ken in accordance with the Spanish code (CTE DBSE-SI).
When selected, the Fire resistance check: General data
dialogue box appears where the properties of the coatings
to be applied to the construction elements are indicated.

Fig. 10.3

10.1.2. Additional loadcases

Additional loadcases may be defined by clicking the op-
tion in the General data dialogue box. The option displays
all the loadcases of the job and allows for them to be edi-
ted as well as allowing for other loadcases to be added
(dead, live, wind, earthquake and snow loads) and esta-
blish their compatibility conditions.

Fig. 10.4

To create a new loadcase, click on the Edit icon to the right
of the name of the loadcase. A dialogue box opens which
will display any additional loadcases that have been defi-
ned. A new loadcase can be added by selecting the New
additional loadcase button in the top left hand corner.

Another dialogue box will appear where the reference and
description can be defined. An extra option appears: With
different load dispositions. By activating this option, the
compatibility of the loadcases can be defined (compatible,
incompatible or simultaneous). This is useful when defining
alternating loads, mobile loads etc.

Fig. 10.5

Fig. 10.6

What are the different load dispositions?

The load dispositions are a group of special loads which
belong to the same loadcase. These can be:

• Compatible: The load groups can be applied on their
own or combined with other load groups belonging to
the same loadcase.

• Incompatible: The load groups do not combine with
other load groups of the same loadcase (for example in
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the case of wind loading where the wind is blowing in a
given direction and will not be combined with wind blo-
wing in another direction).

• Simultaneous: The combinations of the defined addi-
tional dispositions are generated taking into account
that they all act simultaneously. This type can be used
when wishing to define a group of loadcases divided
into load groups and so make them easier to edit, vi-
sualise, etc.

Once the dialogue box has been accepted, and having de-
fined at least two additional loadcases, the program will
display a table at the bottom of the dialogue box where the
combination between loadcases of the same nature can
be combined amongst themselves.

10.1.3. Limit states

Once this option has been selected, the Limit states dia-
logue box appears allowing the user to define the execu-
tion control, use category and snow level. By clicking on
the pencil and question mark icon on the right, the combi-
nation generated by the program can be consulted and
where the partial safety coefficients γ and combination
coefficients γ are indicated.

10.1.3.1. Combination configuration for each limit state

This option can be found in the bottom part of the Limit
states dialogue box and allows to specify the limit states
for concrete, foundations, cold formed steel, rolled steel,
and wood. For any of these, the option Project situations
introduced by the user can be selected. This option al-
lows the user to specify the particular project combinations
to be used situations to in the calculations corresponding
to the structural elements of the job.

Fig. 10.7

Project situations introduced by the user
This option allows to configure particular project situations.
It is carried out in the same manner for all the structural ele-
ment types (Concrete, Foundations, Steel, Timber, Ground
bearing pressure and Displacements).

Fig. 10.8

The following options are available to define the project si-
tuations introduced by the user:

Create new situations

Delete previously introduced situations

Copy the selected situation

Edit the selected situation

Library manager to use the situations in other
jobs

Create based on data of situations stated in the
selected code
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• Create new situations

By clicking on the button, the Create – [Situa-
tions] window will open:

Fig. 10.9

A reference must be introduced to indicate the situation
that is going to be defined. Having done so, click on the
Add new element to the list button and the Combi-
nation coefficients window will open.

Fig. 10.10

Here, the user can define the combinations in two different
ways: by safety factors or by safety and combination fac-
tors.

For the first case, the data to introduce is as follows:

Fig. 10.11

For the second case:

Fig. 10.12

• Edit situations

If this option is selected , dialogue boxes similar to
those displayed when creating the situations appear:

Fig. 10.13

All the previously defined situation parameters can be edi-
ted in this dialogue box.

• Create based on the code situations

By selecting this option ( button), code project si-
tuations of the selected material can be imported and
modified to the user’s needs. This reduces the possibi-
lity of errors occurring when introducing the coefficients.

Warning

By offering the user the option to create the project situa-
tions, the user is given a certain degree of freedom for the
analysis of the job. Therefore special attention must be paid
to not create project situations which may imply that the fi-

CYPE

121CYPECAD - User manual



nal results have an applied safety factor less than that re-
quired by the selected code.

10.2. Definable live loading in groups

10.2.1. Group loads

When introducing new groups (Column Definition tab,
Introduction > Floors/Groups), a live load must be intro-
duced which will be applied on the floors that will subse-
quently be defined. These loads will not be taken into at
openings.

Fig. 10.14

10.2.2. Loads at foundation level

Loads can also be applied at foundation level by selecting
the option Introduction > Floors/Groups > Edit groups
from the Column Definition tab. This load will only be ta-
ken into account by mat foundations.

Fig. 10.15

If there is a mat foundation and no loads have been defined
for the foundation group (0), when launching the analysis,
the program will emit a warning indicating that no loads
have been introduced. The loads may be established at
that point without having to return to the Column Definition
tab. Once the loads dialogue has been accepted the job
analysis will commence.

10.3. Loads Menu

10.3.1. Surface loads on slabs

Within the Loadsmenu in the Beam Definition tab the op-
tion Surface loads on slabs may be found.

This option allows for a surface load to be applied on a slab
by means of a single click.

Fig. 10.16

Once the load has been selected, a dialogue box will ap-
pear where the value of the load and loadcase to which it
belongs must be defined. The button Copy from may be
used to copy the load from another existing load.

By clicking on Add and displacing the cursor over a slab
will cause the slab to be highlighted in yellow. By then
clicking on the mouse button, the load will be applied on
the highlighted slab.
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10.3.2. Automatic introduction of line loads on
beams

The option Line loads on beams is located in the Loads
menu in the Column Definition tab. Upon selecting this
option, a dialogue box will appear which, once accepted,
will allow for line loads to be introduced along the axis of
the selected beams. The introduction may be carried out on
a beam to beam basis or by means of a capture window.

Fig. 10.17

10.4. Drawings and reports
The dead and live loads used in the analysis for each
group can be displayed in the job drawings. These loads
appear in the Special loads drawing (File > Print > Job
drawings > Load distribution, Configure button, Spe-
cial loads). Loads do not appear by default in any other
plans. When selecting the Configure button in the se-
quence described above, a list of other default drawings
will be displayed as well as the Special loads drawing.
These may be edited (Edit, Others tab, Live and dead lo-
ads) to display the applied loads.
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11.1. Baseplates
The program designs baseplates regardless of the layout
of the steel columns and for all types of materials.

The floating menu containing the options relative to base-
plates opens by clicking on Foundations > Baseplates
within the Beam Definition or Results tab.

The menu contains the following options:

Fig. 11.1

• Generate

To be used when there are steel columns or steel bases
without a baseplate. The option generates all the base-
plates at the base of steel columns.

• Delete

Deletes a previously introduced baseplate.

• Edit

Allows for the baseplate to be designed automatically
and verify or consult the layout and arrangement of the
baseplate.

• Match

Copies the properties of one baseplate to another,
once the foundations have been designed.

Using this option the baseplate design proposed by the
program can be modified. The program proposes the
optimum baseplate for each individual column, howe-
ver, it may be useful to reduce the number of different
baseplates used in the job and hence providing a more
uniform result.

Once a baseplate has been copied onto another base-
plate, the program carries out a check to verify that it
does not fail. If any of the conditions are not complied
with, the baseplate is displayed in red.

11.2. Foundations

11.2.1. Foundation properties

The number of columns, walls or shear walls bearing on a
foundation or pile cap is unlimited. The analysis used by
the program is that used for rigid foundations. The user
must ensure this is the case.

Columns, walls and shear walls may be placed in any posi-
tion relative to the axis of the foundation.

11.2.2. Foundation floating menu

The floating menu containing the foundation options is ope-
ned by clicking on Foundations > Foundation elements
in the Beam Definition or Results tab.

Fig. 11.2

The menu contains the following options:

• New
Selection of the type of pad footing: reinforced concrete
footing, mass concrete footing or pile cap.

11. Foundations
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Fig. 11.3

If the pile cap option is selected, the type of pile cap
must be selected. This will establish the shape of the
cap and the number of piles it will rest on. The piles
must then be defined. This is done by selecting the Se-
lection of pile. Here, a description of the pile can be
introduced as well as its shape (circular or square), its
bearing capacity (unfactored) and separation between
pile axes if there is more than one pile for that cap.

Fig. 11.4

Single column elements: having selected this option,
and the type of foundation to be introduced, a column
approached by the mouse cursor will be highlighted in
yellow.

When the cursor is brought close to the column dis-
played in yellow, a square will appear containing a
smaller square whose position will vary depending on
where the mouse cursor is placed relative to the co-
lumn. The smaller square indicates the location the co-
lumn will hold relative to that of the footing if clicked on
at that position.

The default value of the angle of the footing will be the
same as that of the column bearing on it.

Multiple column elements (or combined footing): by
selecting this option, various columns or shear walls

can be selected to bear on the same pad footing (click,
using the left mouse button, on the columns and right
click to finish the selection). The cursor will then adopt
the same shape as in the case of a pad footing with a
single column and the insertion point of the footing will
be displayed (a red target symbol).

The insertion point used by the program is established
by dividing the sum of all the coordinates in each direc-
tion and diving by the number of columns in each direc-
tion, hence obtaining a mean x and y coordinate. This
position may later be modified by the user using the
Move option.

The program uses the angle of the first column introdu-
ced as the default angle of the combined pad footing.

• Edit

Allows for the foundation element to be designed auto-
matically or verified if the user wishes to carry out any
modifications on that proposed by the program or use a
specific reinforcement layout and/or dimensions.

Fig. 11.5

• Delete

Deletes a previously introduced pad footing or pile cap.

CYPE

125CYPECAD - User manual



• Move

Allows for the position of the foundation elements to be
modified.

• Rotate

Rotates the pad footing or pile cap about its centre
axis. The possibilities are as follows:

- Manual introduction of the angle
- Two point introduction. Select two points on the

screen defining the direction vector and click on the
foundation element.

- Angle of the column. Click on the foundation ele-
ment followed by the column bearing on the foun-
dation whose angle is to be adopted. In the case of
several columns bearing on the same foundation,
the angle taken by the program is that of the first
column introduced.

• Join

Allows for several footings to be joined and combined
to make a single footing. Not applicable to pile caps.

The selection of the footings is carried out using the left
mouse button and concluded with a right click.

• Match

Matches the geometry, type and reinforcement of the
pad footings.

Click on the master pad footing from which the proper-
ties are copied, followed by the footing onto which the
properties are to be assigned.

• Information

Displays information on the materials used (including
the allowable bearing pressure of the soil in the case of
footings), the geometry and analysis results (with war-
nings and design errors).

Fig. 11.6

11.2.3. Further options for footings

If the user has acquired the Advanced design of surface
foundations module, then further options are available:

• Polygonal limits for footings

Using this option, the user can define limits or bounda-
ries which cannot be invaded by reinforce concrete or
mass concrete footings. Examples of these limits or
boundaries may include property limits or zones reser-
ved for other uses such as deposits, lift shafts etc.
These limits may also be defined for the program to de-
fine irregular polygonal footings for any other reason,
regardless of whether there are real physical limits.

To define the limits, polylines have to be introduced,
which the program then uses to automatically trim the
footings which pass or invade the established limits in
that group. A footing can be trimmed by more than one
limit. The fraction of the footing in which the column
starts or columns remain is conserved and is, therefore,
what is considered in the analysis. During the design of
the footings, the program does not allow the establi-
shed limits to be exceeded.
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The limits are introduced in CYPECAD using the Limits
for polygonal footings option located in the Founda-
tions menu within the Column definition or Results tab.

The limits may be introduced manually by defining each
edge or by snapping to a DXF/DWG template. In CYPE-
CAD, the limits that have been introduced in a group,
only affect the footings of that group.

Fig 11.7

Once the polylines defining the limits have been intro-
duced, the user may delete or move them, insert a new
vertex or eliminate a section of the polyline.

These polylines have certain logical restrictions regar-
ding their position:

- They cannot intersect a column
- They must cut the outlines of the footings before

and after their design
- Footings with multiple columns cannot be trimmed

in such a way as to leave one column isolated from
the rest of the columns or column starts sharing the
footing.

If a polyline does not comply with one of these condi-
tions, the program will not consider the limit generated
by the polyline.

The defined limits have no effect on strap and tie
beams, pile caps, tapered footings or strip footings.
They only affect reinforced concrete and mass concrete
footings of constant depth.

• Loads applied on footings, pile caps and, strap
and tie beams

Point, line and surface loads can be applied on foo-
tings, pile caps and, strap and tie beams, and are ta-
ken into account in the design. Using this module, CY-

PECAD also recognises the loads transmitted by the
stair supports resting on the aforementioned foundation
elements.

CYPECAD assumes that the soil below the strap and
tie beams does not intervene in the force equilibrium or
distribution to which they are submitted. Therefore,
strap and tie beams are designed to also support any
loads that may be present acting on them and will
transmit the forces to the footings or pile caps at their
ends, or other strap and tie beams they may intersect.

11.2.4. Wall foundations (Strip footings)

When introducing a wall (option Beams/Walls > Define
wall within the Beam Definition tab) regardless of which
type of wall is selected, a dialogue box will appear where
the properties of the new wall are to be defined as well as
its foundation. The wall may be introduced with or without
external fixity. In the case of with external fixity, the wall may
be considered to be Fixed or to bear on a Strip footing
(left or right overhang, or both).

Fig. 11.8

Strip footings are designed automatically.

Strap beams will be required to connect the strip footing to
internal pad footings in order to centre the moment that
arises due to a non-centred strip footing (for example: a
footing with an overhang only on one side).
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If a wall is introduced without a footing, it can easily be as-
signed one later using the Foundation elements option
from the Foundations menu explained above.

11.2.5. Foundation options

Various foundation options can be found having clicked on
the Options button in the General data window. Some of
those options are described below.

Fig. 11.9

Fig. 11.10

• Reduction of minimum mechanical ratio

In the case where the selected code allows for this re-
duction, the minimum mechanical ratio required due to
bending can be applied. This reduction is always ap-
plied during the verification.

Fig. 11.11

• Allow uplift in the footing

If this option is deactivated, uplift will not be allowed in
the footings, that is, the resultant force must pass
through the central nucleus of the footing.

Fig. 11.12

• Do not place top reinforcement mesh if the design
is successful with mass concrete

When the design is being carried out, a top reinforce-
ment mesh will be placed if the mass concrete section
fails for flexure, i.e. a tensile resistance of the concrete
is assumed.
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Fig. 11.13

• Balancing type

This option allows to select the type of pressure distri-
bution acting under the footing as a response of the
soil. (A) Rectangular pressure distribution under the
footing: If this option is selected, the program assumes
that the balancing of the strap beam is perfect, resul-
ting in a rectangular soil pressure distribution. (B) Tra-
pezoidal pressure distribution under the footing: The
program admits that the balancing of the strap beam is
not perfect, that is, a certain rotation of the footing oc-
curs, which leads to a trapezoidal pressure distribution
and therefore, a relaxation of the forces acting on the
beam. This displacement of the resultant force pro-
duces a reduction of the moment on the beam of ap-
proximately 10%.

Fig. 11.14

• Maximum ratio of maximum span-depth. It is the
maximum permissible ratio between the maximum span
amongst all the columns of the footing and the footing
depth to be able to consider the footing as rigid in its
design.

• Maximum ratio of maximum overhang-depth. It is
the maximum permissible ratio between the maximum
overhang and the depth in the design.

Fig. 11.15

11.3. Strap and tie beams

11.3.1. General information on strap and tie beams

Rigid bending is not considered in the case of tie beams or
strip footings however it is in the case of strap beams which
balance the load and act as tie beams (they absorb the
moments produced at the base of the columns, due to the
eccentricity of the force normal to the columns with respect
to the axes of the footings and transferred to the axes of the
footing).
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The program does not consider the beams to be suppor-
ted by the ground.

The program allows the user to assign the ‘balancing’ to
one or both ends. For example, in the case of a beam run-
ning from a centred pad footing (with respect to the co-
lumn) to an eccentric pad footing, the user can balance the
end reaching the eccentric footing and leave the other as a
tie beam.

11.3.2. Strap and tie beam floating menu

The strap and tie beam floating menu which opens upon
clicking on Foundations > Strap and tie beams in the
Beam Definition and Results tabs contains the various
options related to the beams:

Fig. 11.16

• New beam

When introducing a new beam, the user can choose
between:

- Tie beam
- Strap beam. These balance the moments transmit-

ted by the columns, shear walls and walls to the
foundations relative to their axes. Any type of foo-
ting can be balanced.

- Beam with automatic balancing at ends. Using this
option, the user can introduce a beam between two
previously introduced footings and the program will
automatically balance the ends which require ba-
lancing because the footing they reach is eccentric
with respect to the supported element(s) (e.g. edge
footing, corner footing, etc.).

Fig. 11.17

• Edit beam design

After the general analysis, the result obtained for the
beam can be modified. The footing can be designed
independently and later on, design the beam.

Fig. 11.18

To do so, select a beam, and click on the Edit button. A
window containing the following options will open:
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- Selection. This allows for the type of beam to be
modified. The new beam (of the same type) can be
selected from the scroll list.

Fig. 11.19

- Stirrups. If the options are activated, the stirrups of
the strap beam will be extended into the foundation
up to the column starter bars.

Fig. 11.20

- Anchorage. Modifies the anchorage lengths.

Fig. 11.21

- Code checks. Verifies the current beam. Once the
process has concluded, a list of all the verifications
that have been carried out is available.

Fig. 11.22

- Design. Automatically designs the beam and ap-
plies all the conditions stated in the code selected
by the user. Once the process has concluded, a list
of all the verifications that have been carried out is
available.

- Detailing. A transverse and longitudinal section of
the beam is displayed, with its reinforcement and di-
mensions.

- 3D view. Provides a 3D view of the beam.

Fig. 11.23
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• Delete beam

Deletes a previously introduced beam.

• Balance ends

Allows for the balancing action to be activated or deac-
tivated upon clicking at the end in question. If the strap
beam balances the load at a specific end, a curved ar-
row will appear indicating that the balancing is active. If
the arrow does not appear, the balancing at that end is
not active.

• Match

This option allows to copy the selected strap beam type
from the foundations of the analysed job to other strap
beams of the same job. It also allows to copy tie beams
in a similar manner.

Using this tool, it is possible to match the strap beam
sections proposed by the program having analysed the
job. This way, the number of different beams of the job
can be reduced, obtaining more uniform results.

A strap or tie beam can be copied onto another strap or
tie beam with a larger section. In this case, the beam
will be drawn in red to indicate that it has an insufficient
section.

The anchorage lengths of the copied beams are redesi-
gned after the assigning has taken place. The master
beam will remain unchanged.

11.3.3. Further options for strap and tie beams

If the user has acquired the Advanced design of surface
foundations module, then further options are available:

• Loads applied on footings, pile caps and, strap
and tie beams

Point, line and surface loads can be applied on foo-
tings, pile caps and, strap and tie beams, and are taken
into account in the design. Using this module, CYPE-
CAD also recognises the loads transmitted by the stair
supports resting on the aforementioned foundation ele-
ments.

CYPECAD assumes that the soil below the strap and
tie beams does not intervene in the force equilibrium or
distribution to which they are submitted. Therefore,
strap and tie beams are designed to also support any
loads that may be present acting on them and will
transmit the forces to the footings or pile caps at their
ends, or other strap and tie beams they may intersect.

• Strap and tie beam intersections

Using the Advanced design of surface foundations
module, CYPECAD can design foundations consisting
of footings or pile caps with intersecting strap and tie
beams.

11.4. Automatic generation of footings and
beams
This option will automatically generate footings and beams
according to the established parameters.

A window will open where the parameters to be used in the
generating process are to be introduced.

The overhang will be equal to zero if, in one direction, there
is a column directly in front but not on the other side.
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Vision distance (D) and angle (A). Any facing columns
whose axis alignment differs from that of the generating co-
lumn by a distance less than ‘D’, as long as the contained
angle is within the angle of vision ‘A’.

Maximum separation between column axes to create foo-
ting. The maximum distance, by default, between the co-
lumn axes to create a combined footing is 1 m (limit maxi-
mum value: 3 m).

Having generated the foundation, the footings and beams
can be modified, using the Edit option from the Founda-
tion elements or Strap and tie beam floating menus.

11.5. Analysis and results

11.5.1. Design

This option analyses and designs the foundations which
can be composed of pad footings, strip footings, pile caps,
baseplates, and strap and tie beams.

Fig. 11.24

For those cases where errors or warnings appear when
designing certain elements, a warning will be emitted at the
time of executing the option, after which, the option Code
check errors should be selected.

There may be more than one foundation level. Here, it is
equally possible to select the floor groups for which the
foundation is to be designed.

There are three design options explained in the on screen
help of the program.

Bear in mind that the complete structure has to be analysed
to obtain the forces at the base of the columns.

11.5.2. Code check errors

After the analysis, if this option is activated, the foundation
elements with design errors will be displayed in red. By
clicking on the element in question, a message will appear
informing the user of the errors that have occurred during
the design.

11.5.3. Eliminate overlaps

Once the foundation has been analysed, if there are over-
lapping footings, a warning will be emitted and this option
can be used to modify the layout of the elements.

For those cases where all the overlaps have been elimina-
ted, the program will place a combined footing under the
columns.

11.6. Reports and drawings

11.6.1. Foundation report

A report is provided by the program containing the data in-
troduced: footings, pile caps, strap and tie beams and ba-
seplates displaying their dimensions and the verifications
that have been undertaken.
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Fig. 11.25

11.6.2. Foundation and foundation reinforcement
floor plans

Within the selection of floor plans, there are two types of
layouts available for the foundations: Foundation and
Foundation reinforcement.

Fig. 11.26

In the first case, the foundation layout on the floor is drawn,
as well as the column starts, reinforcement and dimensions
of the foundations and the foundation and strap and tie
beam schedules.

Fig. 11.27

In the second case, the drawings of the footings, pile caps
and baseplates are displayed.

Fig. 11.28

The floor layout drawing configuration tab contains two op-
tions: Footings/ Pile caps and Foundation.
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The first option contains all the data regarding the layout on
the floor and the column starts. The second the drawings
and reinforcement schedules.

Fig. 11.29 Fig. 11.30

In the layout drawing the footings, pile caps, piles, pile ta-
bles, etc. are drawn.

Fig. 11.31



12.1. Contour maps
Contour maps can be accessed by selecting the Contour
maps tab at the bottom of the CYPECAD window. The
force and displacement graphics are displayed in colours
whereby each tone possess a value detailed on a scale in
a floating menu. The contour lines can equally be repre-
sented.

Fig. 12.1

A colour key is displayed at the bottom of the screen indi-
cating the respective values associated to the colours as
well as the maximum and minimum values at either end of
the key scale.

The contour lines are graphics similar to those of elevation
levels in topographic maps, except in this case, each line
represents the geometrical position of the points with the
same force or displacement.

The contour maps or contour lines can be attached and
printed out.

12.1.1. Loadcases and floors window

The Contour map window contains a
floating menu called Loadcases and flo-
ors. Here, the visibility of the contour lines
and their values can be activated or deac-
tivated. The loadcase or combination
loadcase the contour map refers to can
be selected, as well as what is to be repre-
sented in the contour map (force, displacements, etc.).

The displacement diagrams, force diagrams and steel area
diagrams for waffle, solid and flat slabs are represented per
floor and in colour. They represent the loadcase selected at
that moment.

Displacements
The contour maps and lines of the floors can be viewed per
loadcase or combination loadcase.

• Displacement z. Vertical displacement. Units in mm.
Negative values represent a vertical descent.

• Rotation x. Rotation about the x axis of the mesh.

• Rotation y. Rotation about the y axis of the mesh.

Forces
The forces can be selected for a given loadcase or combi-
nation loadcase.

• Total shear. Square root of the sum of the shear in X
squared and the shear in Y squared.

• Shear X. Shear force in the X axis of the mesh.

12. Contour maps and deformed shape
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• Shear Y. shear force in the Y axis of the mesh.

• Moment X. Bending moment in the X axis of the mesh.

• Moment Y. Bending moment in the Y axis of the mesh.

• Moment XY. Torsion in the floor plan.

Design stresses
The design stresses can be selected. The design stress at
a point is the value of the force envelope at that point which
results in having to provide the worst case reinforcement.

• Total shear. Square root of the sum of the shear in X
squared and the shear in Y squared.

• Shear X. Shear force in the X axis of the mesh.

• Shear Y. Shear force in the Y axis of the mesh.

• Moment X, bottom steel. Bending moment in the X axis
of the mesh used for the design of the bottom steel.

• Moment Y, bottom steel. Bending moment in the Y axis
of the mesh used for the design of the bottom steel.

• Moment X, top steel. Bending moment in the X axis of
the mesh used for the design of the top steel.

• Moment Y, top steel. Bending moment in the Y axis of
the mesh used for the design of the top steel.

Steel areas
The steel areas displayed in the contour maps represent
the steel area required for the design stress at that point i.e.
the worst case reinforcement.

The steel to be seen can be that of the top or bottom in the
X or Y direction.

Ground bearing pressures
This option is available in the case of mat foundations.

• Maximum bearing pressure. Worst case bearing pres-
sure of the slab on the soil.

• Uplift. Value of the uplift in mm.

• By loadcase. Bearing pressure by loadcase or combi-
nation loadcase.

Some of the options present a Maximum value and/or Mini-
mum value option. These allow to limit the values displayed.
The colour order does not vary upon modifying the range,
only the values they represent change. These will be dis-
played in the colour key at the bottom of the screen. This op-
tion is very useful to obtain a more precise view of the values.

It is equally possible to select a single limit to locate the
point at which the maximum or minimum value occurs.

These options allow, for example, to view which areas of a
slab require additional reinforcement to that of the base
reinforcement, in which areas can a certain reinforcement
diameter be used, etc.

In the case of the bearing pressure option, it is useful to
view if there are areas which are greater than the allowable
bearing pressure, by introducing the value in the minimum
value option.

12.1.2. Forces menu

This option allows to view the forces in beams, joists, hol-
low core slabs and composite slabs. The results can be
displayed by loadcase, combination loadcase or envelope.

12.1.3. Flat/Waffle slabs menu

This menu contains the same options that can be found in
the Flat/Waffle slabs menu within the Results tab; whe-
reby the user can view and modify the reinforcement.

A third option is available: Deflection between two
points. The user can visualise the secant or tangential de-
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flection at a point, and for each of these, their respective
maximum relative, maximum absolute or the deflection bet-
ween the two points. Additionally, the user may select the
simple loadcase, combination loadcase, worst case com-
bination and amplification factor for which the deflection va-
lues are going to be calculated.

This last option can also be accessed in the Envelopes
menu within the Results tab.

12.1.4. Window menu

The contour maps and force envelopes can be consulted
simultaneously in several windows, in such a way that, for
example, the floor displacement values can be seen for the
dead load loadcase and the live load loadcase at the same
time. In a similar way, the corresponding windows can be
obtained for different floors. The definition of the window
remains whilst the user is not in the Contour map tab but
not if the program is closed.

Fig. 12.3

12.2. Deformed shape

12.2.1. 3D view of the deformed shape of the struc-
ture

Once the job has been analysed, the deformed shape of
the structure can be seen. It is possible to view the maxi-
mum deformation caused by a simple loadcase or combi-
nation loadcase.

This option appears in the Deformed Shape tab.

Fig. 12.4

Within this window, the Deformed shape dialogue box ap-
pears in which a series of options can be defined to confi-
gure how the deformed shape is viewed. The following op-
tions are available:

• View the deformed shape due to a simple loadcase or
combination loadcase.

• Selection of the loadcase or combination loadcase.

• Factor

• View the structure (display structural elements or dis-
play simplified structure)
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• View waffle and flat slabs

• Deformed shape animation

Fig. 12.5

Each of the options described above contains a help on
screen describing their use.

Viewing the deformed shape and its animation are efficient
tools to identify if there is any unusual behaviour in the
structure and any issues due to its design or external ac-
tions.

12.2.2. Indication of the deformation using a colour
scale.

The structural elements (in their deformed positions) are
drawn with an applied colour scale, depending on their dis-
placement when a loadcase or combination loadcase is
selected. This way, it is easy to distinguish the way in which
the individual elements of the structure are deformed resul-
ting in the overall deformation of the structure.

The key to the colour scale is indicated at the bottom of the
screen. The value of the displacement represented on
screen is the vector result of the three components: ∆x, ∆y
and ∆z.

In a similar way as with the Contour maps, several windows
can be opened simultaneously to be able to view and com-
pare the deformed shape when different loadcases or
combination loadcases are applied.
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13.1. Reinforcement tables
The program contains predefined reinforcement tables for all
the reinforced concrete elements in CYPECAD. All the tables
can be edited and modified. It is equally possible to create
new, completely independent tables. The tables are mana-
ged in Steel types in bars window which opens by clicking
on the By position option in the General data window.

Fig. 13.1

Using the icons, the user can access the chosen table.

Fig. 13.2

13.1.1. Use of the reinforcement tables

During the analysis, the program chooses the required rein-
forcement to resist the applied forces and moments from
the selected table.

If no suitable reinforcement is found, the program emits a
warning and the user should revise the reinforcement table.

When a table is created or modified, verify the coherence of
the data introduced.

13.1.2. Restore default tables

This button, located at the bottom of the Steel types in
bars window, allows to restore the original or predefined
(in case they have been modified) reinforcement tables.
When restoring the default tables, if they are different to
those modified by the user, the program will ask which ta-
bles are to be saved.

In any case, tables added by the user to the predefined ta-
bles are saved.

13.2. Section library
CYPECAD contains predefined section libraries. These li-
braries are provided by the manufacturers and allow for the
sections to be used directly as their dimensions and pro-
perties have already been defined.

It is equally possible to create new sections and new libraries.

13. Tables and libraries
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13.2.1. Edition of an individual section

A new section can be created by selecting the Editable
option in the Section data field from the Section descrip-
tion window. All the dimensions and properties can be mo-
dified.

Fig. 13.3

Fig. 13.4

13.2.2. Library manager

When sections from a library are to be used, the library
must first be imported into the job section library.

13.2.2.1. Use of existing libraries

The libraries are managed in the Section library which
opens by clicking the Job sections button in the Section
description window.

Fig. 13.5

The library which appears by default is that defined in the
Section library which opens by clicking the Job sections
button.

Fig. 13.6

Other libraries can be imported by clicking the import icon .

13.2.2.2. Library edition

It is possible to attach sections to the job library by clicking on
the icon. Sections can be copied by clicking on the
icon, edited by clicking and deleted using the icon.

13.2.2.3. Library creation
A new library can be created by either directly creating a
new library in the Library selection window (accessed by
clicking the Library management button) and importing
the selected sections, or by exporting specific sections of
the job using the icon from the Section library window.
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